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  概要 

UWB（ウルトラワイドバンド）テクノロジーは、免許不要の周波数帯で動作するデバイス間通信用の近距離
広帯域無線テクノロジーです。モバイルデバイス間の正確でセキュアなピアツーピア測距を可能にする最適
な RF位置決めテクノロジーであり、きわめて小さい消費エネルギーで高い耐干渉性を発揮し、他の無線通
信システムとの共存も容易です。UWB は、資産トラッキング、セキュア決済、パーソナルトラッカー、リア
ルタイム位置情報サービス、車両へのキーレスアクセス／始動など、さまざまなアプリケーションに使用さ
れます。米国調査会社 ABI Research（ABIリサーチ）の予測によると、2026 年までに、UWB デバイスの年間
出荷台数は 10 億を大幅に上回る見込みです。2026 年に出荷されるほぼすべてのスマートフォンで UWBサー
ビスがサポートされるようになります [1]。 

UWBデバイスのテスト面について言えば、一般に他の無線製品と同様に、2 つのテスト方法を採用できま
す。1 つは、電子計測器と被試験デバイス（DUT）の間を有線で RF接続する従来のテストモード（いわゆる
伝導テスト）で、もう 1 つは OTA 電波暗室での無線（OTA）テストモードです。コスト、スペース、複雑
さ、製品の RFコネクタへのダイレクトアクセスなどの制限要因により、伝導モードでテストできるとは限
らない場合もあれば、伝導モードでのテストが必ずしも必要ではない場合もあります。この場合は、OTA テ
ストは避けられない方法になってきます。さらに、OTA テストは実条件での DUTの使用を反映していま
す。 

このアプリケーションノートでは、無線製造テスト（WMT）環境におけるトランスミッター（Tx）、レシー
バー（Rx）、Time of Flight（ToF）テストに対応する R&S® OTA テストソリューションについて説明しま
す。本書に記載されている測定結果は、NXPの Trimension™ NCJ29D5 UWB車載用 ICに基づいています。 

伝導モードでの UWBデバイスのテストについては [2]に記述されており、R&S®のその他の自動車用アクセス
制御テストソリューションについては、このリンク先に記載されています。 

このアプリケーションノートの残りの部分は、以下のような構成になっています。 

第 1 章では、UWB の基礎について説明します。 

第 2 章では、OTA の基本について簡単に紹介します。 

第 3 章では、UWB OTA テストソリューションについて詳しく説明します。内容としては、テストソリュー
ションのハードウェア／ソフトウェア要件、Tx、Rx、ToFテストに関する知識などがあります。 

付録では、紹介したテストソリューションに関連する有用な情報を、参考のために紹介します。 

このアプリケーションノートでは、R&S®製品に関して以下の略称を使用します。 

R&S®CMP200 無線機テスタは、CMP200 と記します。 

R&S®CMQ200 高シールド（HS）シールドボックスは、CMQ200 と記します。 

https://www.rohde-schwarz.com/us/solutions/test-and-measurement/automotive/automotive-connectivity-and-infotainment/vehicle-access-control/connectivity-remote-keyless-entry_231908.html
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R&S®CMQ500 シールドボックスは、CMQ500 と記します。 

R&S®CM-Z300A UWB走行時間（ToF）測定用アクセサリキット（CMP200 用）は、ToFキットと記します。 

R&S®SP6T RF接続キットは、RFスイッチと記します。 

R&S®WinIQSIM2 信号発生ソフトウェアは、WinIQSIM と記します。 

このアプリケーションノートの読者は、UWB 物理層に関する基本的知識があることを前提とします。前提知
識が十分でない場合は、UWBホワイトペーパー [3]で、基礎知識、テスト、認証または UWB IEEE 802.15.4 

[4]/IEEE 802.15.4z規格 [5]に関する詳細をご覧ください。 
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R&S®は、このアプリケーションノートに対する貴重な技術的貢献に関して、NXP®カスタマーアプリケーシ
ョンサポートに心より感謝いたします。 
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1 UWBの基礎 

この章では、UWB テクノロジーの基礎について説明します。 

1.1 規格 

高レートパルス繰り返し（HRP）UWB物理層は、IEEE 802.15 ファミリーのタスクワーキンググループの 1

つである IEEE802.15.4 で標準化されています。この規格では、HRP UWBの物理層プロトコルデータユニット
（PPDU）、変調、RF 要件（動作周波数バンド、チャネル割り当て、ベースバンドインパルス応答、送信パ
ワースペクトラム密度 PSDマスクなど）が定義されています。 

IEEE802.15.4z規格は IEEE802.15.4 の修正版であり、HRP UWB物理層に基づく強化された測距デバイス
（ERDEV）、通称 HRP-ERDEV の仕様が記されています。HPR-ERDEV は 2 つのモードで動作します。1 つ
はパルス繰り返し周波数（PRF）が公称 64 MHzのベースパルス繰り返し周波数モード、もう 1 つは PRF が
124.8 MHzまたは 249.6 MHzのハイパルス繰り返し周波数（HPRF）モードです。 

自動車業界では、グローバルな業界団体の Car Connectivity Consortium®（CCC）が 2011 年に設立されまし
た。この団体は、小型自動車やモバイルデバイスで一貫して優れたユーザー体感を提供するためのインタフ
ェースの標準化を目指しています。CCC デジタルキー規格によって、スマートフォンを自動車キーとして広
く採用することが可能になりました。最新のデジタルキーリリース 3.0 では、IEEE 802.15.4z規格に基づく
UWBセキュア測距テクノロジーと、標準の Bluetooth®Low Energy 接続 [6]の組み合わせにより、ハンズフリ
ーの位置認識型キーレスアクセスと、位置認識機能が追加されています。 

2019 年に設立された FiRa® Consortiumは、コンプライアンスおよび認証プログラムを通じて複数のデバイス
の間の相互運用性を確保することで、UWBエコシステムの拡大を目指す組織です。 

このアプリケーションノートでは、IEEE 802.15.4 および IEEE 802.15.4z規格を、それぞれ 802.15.4 および
802.15.4zと記します。 

1.2 UWBの周波数とチャネル 

802.15.4 [4]に基づく UWBのチャネル割り当てを表 1‑1 に示します。 

HRP UWB物理層は、3 つのバンドグループ内の 16 のチャネルで動作します。バンドグループには、サブギ
ガヘルツ（subGHz）、ローバンド、ハイバンドがあり、それぞれバンドグループ 0、1、2 と呼ばれます。 
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バンドグループ 周波数レンジ チャネル
番号 

中心周波数（MHz） 帯域幅 

（MHz） 

必須（M）／オプシ
ョン（O） 

0（subGHz） 249.6 MHz～749.6 MHz 0 499.2 499.2 M 

1（ローバンド） 3.1～4.8 GHz 1 3494.4 499.2 O 

2 3993.6 499.2 O 

3 4492.8 499.2 M 

4 3993.6 1331.2 O 

2（ハイバンド） 6.0～10.6 GHz 5 6489.6 499.2 O 

6 6988.8 499.2 O 

7 6489.6 1081.6 O 

8 7488 499.2 O 

9 7987.2 499.2 M 

10 8486.4 499.2 O 

11 7987.2 1331.2 O 

12 8985.6 499.2 O 

13 9484.8 499.2 O 

14 9984 499.2 O 

15 9484.8 1354.97 O 

表 1‑1：HRP UWB 物理層のチャネル割り当て 

チャネル 4、7、11、15 を除き、各チャネルの帯域幅は 500 MHzです。チャネル 0、3、9 のサポートは、関
連するバンドでの UWB実装に必須です。現在市販されている UWB製品のほとんどは、チャネル 5～9 のハ
イバンドグループ専用です。 

例えば、NXP Trimension™ NCJ29D5 デバイスは、6 GHz～8.5 GHzのハイバンドで動作します。 

1.3 UWB物理層の信号特性 

1.3.1 UWB波形 

ロールオフ係数 β＝0.5 のルートナイキスト（RRC）パルスシェーピングを、基準パルスとして適用するこ
とが必須です（式 1‑1 を参照）。 そのインパルス応答 r(t)は次のとおりです。 

𝑟𝑟(𝑡𝑡) =
4𝛽𝛽
𝜋𝜋�𝑇𝑇𝑝𝑝

 
cos�(1 + 𝛽𝛽)𝜋𝜋𝜋𝜋 𝑇𝑇𝑝𝑝⁄ � + 

sin�(1 − 𝛽𝛽)𝜋𝜋𝜋𝜋 𝑇𝑇𝑝𝑝⁄ �
4𝛽𝛽𝛽𝛽 𝑇𝑇𝑝𝑝⁄

1 − �4𝛽𝛽𝛽𝛽 𝑇𝑇𝑝𝑝⁄ �2
 

 

式 1‑1：UWBのインパルス応答 

ここで、Tpはパルスの持続時間（ns単位）です。 
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1.3.2 フレーム構造 

HRP測距対応デバイス（HRP-RDEV）は、802.15.4 [4]に準拠した物理層実装に基づく測距機能を支援しま
す。 

HRP-RDEV の物理層プロトコルデータユニット（PPDU）のフレーム構成は、図 1‑1 に示すように、同期ヘ
ッダー（SHR）、物理層ヘッダー（PHR）、物理層サービスデータユニット（PSDU）から構成されます。 

 

図 1‑1：UWB HRP-RDEVの PPDU（802.15.4） 

802.15.4 規格の増補版である 802.15.4zは、高度にセキュアで精密な測距に対する需要の高まりに応えるもの
です。主な機能拡張は次のとおりです。 

► HRP PPDU フォーマットへの STS（Scrambled Timestamp Sequence）の導入  

► プリアンブルおよびデータフィールドへの PRF増加の適用  

これらの機能拡張をサポートするデバイスは、HRP-ERDEV（HRP Enhanced Ranging Device）と呼ばれます。
次の 2 つの必須機能がサポートされる必要があります。 

► 公称 PRF 64 MHz のベースパルス繰り返し周波数（BPRF）モードでの動作  

► 124.8 MHzまたは 249.6 MHzの高い PRFのハイパルス繰り返し周波数（HPRF）モードでの動作  

1.3.3 同期ヘッダー（SHR） 

同期ヘッダー（SHR）は、プリアンブルとフレーム開始デリミター（SFD）から構成されます。 

1.3.3.1 プリアンブル 

プリアンブルコードインデックス 
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SHRのプリアンブル部分は、タイミング同期、パケット検出、キャリア周波数オフセットの回復に用いられ
ます。 

各プリアンブルシンボルは、3 値アルファベット{–1,0,1}で作成された定義済みのプリアンブルコードシーケ
ンスから構成されます。802.15.4 [4]では、必須の長さ 31 のプリアンブルコードシーケンスと、オプション
の長さ 127 のプリアンブルコードシーケンスが仕様化されています。表 1‑2 には、チャネルに依存する長さ
31 のプリアンブルコードシーケンスが、個々のインデックス（1～8）とともに記されています。 

インデック
ス 

コードシーケンス Ci チャネル番号 I 

1 - 0 0 0 0 + 0 - 0 + + + 0 + - 0 0 0 + - + + + 0 0 - + 0 - 0 0 0, 1, 8, 12 

2 0 + 0 + - 0 + 0 + 0 0 0 - + + 0 - + - - - 0 0 + 0 0 + + 0 0 0 0, 1, 8, 12 

3 - + 0 + + 0 0 0 - + - + + 0 0 + + 0 + 0 0 - 0 0 0 0 - 0 + 0 - 2, 5, 9, 13 

4 0 0 0 0 + - 0 0 - 0 0 - + + + + 0 + - + 0 0 0 + 0 - 0 + + 0 - 2, 5, 9, 13 

5 - 0 + - 0 0 + + + - + 0 0 0 - + 0 + + + 0 - 0 + 0 0 0 0 - 0 0 3, 6, 10, 14 

6 + + 0 0 + 0 0 - - - + - 0 + + - 0 0 0 + 0 + 0 - + 0 + 0 0 0 0 3, 6, 10, 14 

7 + 0 0 0 0 + - 0 + 0 + 0 0 + 0 0 0 + 0 + + - - - 0 - + 0 0 - + 4, 7, 11, 15 

8 0 + 0 0 - 0 - 0 + + 0 0 0 0 - - + 0 0 - + 0 + + - + + 0 + 0 0 4, 7, 11, 15 

表 1‑2：長さ 31の 3 値プリアンブルコードシーケンス [4] 

長さ 127 の 3 値プリアンブルコードシーケンスの使用はオプションです。長さ 127 の 3 値シーケンスは、イ
ンデックス 9～24 の合計 16 種類が仕様化されています。長さ 31 のプリアンブルコードシーケンスと同様、
適用されるプリアンブルインデックスはチャネルに依存します。長さ 127 のプリアンブルコードシーケンス
の詳細は、802.15.4 の表 15-7 [4]に記載されています。 

HRP-ERDEV の場合は、これに加えて、長さ 91 の 3値プリアンブルコードシーケンス（コードインデックス
25～32）のサポートが必須です。長さ 31 および長さ 127 の場合と異なり、長さ 91 のコードインデックスは
チャネルに結び付いていません。長さ 91 のプリアンブルコードシーケンスの詳細は、802.15.4zの表 15-7a 

[5]に記載されています。 

プリアンブル長 

プリアンブルコードが拡散されてプリアンブルシンボルを構成し、そのプリアンブルシンボルが繰り返され
て、SHRの SYNCフィールド部分が構成されます（図 1‑2 の例を参照）。SYNC フィールドはプリアンブル
シンボルの単純な繰り返しであり、プリアンブルシンボルの繰り返し回数は、802.15.4 [4]に定義されている
ように、16、64、1024、4096 です。HPRF モード（PRF＞64 MHz）の場合、802.15.4z [5]に定義されているよ
うに、HRP-ERDEV は 32 および 64 のプリアンブルシンボルの繰り返しをサポートし、オプションで 16、
24、48、96、128、256 もサポートします。 

                                                 

 

Iチャネル間通信が必要な場合、コードインデックス 1～6は、HRP UWBチャネル 4、7、11、15（チャネル帯域幅＞500 MHz）でも使用できま
す。 
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図 1‑2：拡散によるプリアンブルシンボル Siの構成 [4] 

プリアンブル長（16、32、64、1024、4096）は、プリアンブルシンボルの繰り返し回数を表します。 

1.3.3.2 フレーム開始デリミター（SFD） 

SFDは、プリアンブルの終了と、物理層ヘッダー（PHR）の開始を示します。 

SFDタイプ 

SFDは、必須の 8 シンボル（ショート）とオプションの 64 シンボル（ロング）をサポートします（表 1‑3

を参照）。どちらが用いられるかは、HRP-RDEV の以後の送信データレートによって決まります [4]。 

SFD長 用途 サポート 

 64 シンボル（ロング） 低データレート（110 kbps）用 オプション 

 8 シンボル（ショート） その他のデータレート用 必須 

表 1‑3：HRP-RDEVの SFDシーケンス（802.15.4） 

HRP-ERDEV の SFDタイプは表 1‑4 [5]に示されています。 

SFDタイプ SFD長 モード サポート 

0 8II BPRF 必須 

1 4 HPRF 必須 

2 8 BPRF / HPRF 必須 

                                                 

 

II HRP-RDEV（802.15.4）のショート SFD シーケンス（8 シンボル長に相当）（表 1‑3 を参照）  
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SFDタイプ SFD長 モード サポート 

3 16 HPRF 必須 

4 32 HPRF オプション 

表 1‑4：HRP-ERDEVの SFDシーケンス（802.15.4z） 

1.3.4 物理層ヘッダー（PHR）と物理層サービスデータユニット（PSDU） 

仕様 [4] [5]に基づき、PHR と PSDUのデータレートは、使用中の PHR データレートモードに応じてあらか
じめ定義されています。対応する PHRビットレートと、関連する PSDUビットレートの詳細については、
HRP-RDEV に関しては表 1‑5、HRP-ERDEV に関しては表 1‑6 および表 1‑7 を参照してください。 

PHRデータレートモー
ド 

PHRビットレート（Mb/s）  PSDUビットレート（Mb/s）  

DRMDR 0.85 または 0.11 0.11 / 0.85 / 6.8 / 27.2 

表 1‑5：HRP-RDEVの PHRおよび PSDUデータレート（802.15.4） 

PHRデータレートモー
ド 

PHRビットレート（Mb/s）  PSDUビットレート（Mb/s）  

DRBM_LP 0.85 6.8 

DRBM_HP 6.8 6.8 

表 1‑6：HRP-ERDEVの BPRFモードの PHRおよび PSDUデータレート（802.15.4z） 

PHRデータレートモー
ド 

ビタビ制約長 PHRビットレート
（Mb/s） 

PSDUビットレート
（Mb/s） 

平均 PRF（MHz） 

DRHM_LR CL3 3.9 6.8 124.8 

DRHM_LR CL7 7.8 7.8 124.8 

DRHM_HR CL3 15.6 27.2 249.6 

DRHM_HR CL7 31.2 31.2 249.6 

表 1‑7：HRP-ERDEVの HPRFモードの PHRおよび PSDUデータレート（802.15.4z） 

1.3.5 STS（Scrambled Timestamp Sequence） 

802.15.4z [5]では、データインテグリティを強化するため、STS（Scrambled Timestamp Sequence）を含む新
しいフレーム構造が導入されました。これは基本的に、AES-128 暗号化アルゴリズムを使用して作成された
パルスのシーケンスであり、HRP UWBの物理層フレーム構造に追加されます。 

STSのパケット構造（0、1、2、3） 

フレーム内での STS部分の位置に応じて、4 種類の STSパケット構造が定義されています（図 1‑3 を参
照）。各 STS パケット構成で、RMARKERはレガシーRDEV と同じ役割を果たし、フレームのタイムスタン
プの基準ポイントとなります。 
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図 1‑3：STS（Scrambled Timestamp Sequence）のパケット構成 

SP3 は PHRと PSDUを含まないことに注意してください。このため、データ部分の測定が必要な場合、SP3

は避ける必要があります。 

STSの生成方法を下の図 1‑4 に示します。 

 

図 1‑4：STSの生成（拡散長 4、HPRF） 

各 HRP-ERDEV モードに関連する STSパラメータを表 1‑8 に示します。 

HRP-ERDEVモード 拡散長 L パルス間隔（チッ
プ数） 

平均 PRF（MHz） STS長（512 チップ単
位） 

サポートされるセグメ
ント数 

BPRF 8 8 62.4 64 1 

HPRF  4 4 124.8 32, 64, 128, 16III, 256III 1, 2, 3III, 4III 

表 1‑8：STSパラメータ 

STSインデックス 

波形発生用の STSのインデックスは、0～232の任意の整数です。 

                                                 

 

III オプション 
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STS長 

STS長は、各 STSセグメントの長さを 512 チップ単位で表します。表 1‑8 に示すように、値は 16、32、
64、128、256 のいずれかです。 

STSセグメント数 

STSセグメント数は、STS フィールド内のセグメントの総数を表します。HPRF の場合は、最大 4 セグメン
トがサポートされます（表 1‑8 を参照）。 

1.4 走行時間（ToF） 

UWBテクノロジーでは、ToF法による距離測定が用いられます。ToFとは基本的に、イニシエーター（タ
グ）とレスポンダー（アンカー）の間で信号が自由空間を伝搬する時間です。その推定値は、信頼性の高い
堅牢な測距タイムスタンプに基づきます。 

双方向測距（TWR）は、2 台の UWBデバイスの間の距離を測定する一般的な方法の 1 つで、特にデバイスの
間にクロック同期がない場合に多く用いられます。すなわち、各デバイスは自身のクロック基準を使用して
独立に測定を行います。2 台のデバイスの間の ToFがわかれば、距離は ToFと光速の積として容易に計算で
きます。 

以下の各セクションでは、SS-TWR（Single-Sided Two-Way Ranging）と DS-TWR（Double-Sided Two-Way 

Ranging）の 2 種類の TWR方式について説明します。 [5]での修正により、測距機能がさらに強化され、STS

を使用したセキュア測距がサポートされるようになりました（1.3.5 を参照）。これは、攻撃者が距離偽装攻
撃によって距離推定プロセスを操作するのを防ぐものです。 

1.4.1 SS-TWR（Single-Sided Two-Way Ranging） 

 

図 1‑5：SS-TWR（Single-Sided Two-Way Ranging） 

図 1‑5 に示すように、デバイス A（タグ）が ToFを推定することによりデバイス B（アンカー）までの距離
を判定しようとしています。デバイス A は測距フレーム（PHRの RFRAMEフラグがセットされているも
の）を通じてデバイス Bにポーリングメッセージを送信し、最終的にデバイス Bから返された応答メッセー
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ジを受信します。RMARKERは、RFRAMEの PHR の最初のシンボルの先頭がローカルアンテナに到達した時
刻と定義されます。これは、メッセージの往復時間を測定するためのストップウォッチの役割を果たしま
す。 

いくつかの時間差が測定または計算されます。Tpropは、無線での伝搬時間です。時間 TAroundおよび TBreplyは、
デバイス A と Bで独立に、それぞれのローカルクロックを使用して測定される処理時間です。TBreplyの測定
結果は、デバイス Bから A への応答メッセージに載せて送られます。TAroundと TBreplyを知ることで、デバイ

ス A は自身の ToFを𝑇𝑇𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝＝
𝑇𝑇𝐴𝐴𝐴𝐴𝐴𝐴𝐴𝐴𝐴𝐴𝐴𝐴－𝑇𝑇𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵

2
という式で計算します。距離は𝑐𝑐𝐴𝐴𝐴𝐴𝐴𝐴 × 𝑇𝑇𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝となります。ここで、

𝑐𝑐𝐴𝐴𝐴𝐴𝐴𝐴は光速（29.97 cm/ns）です。 

SS-TWRでは、トランスミッター側とレシーバー側のクロックが同期されている必要はありません。ただし
実際には、両方の側のクロック発振器の不完全性から生じるクロックジッタやクロックオフセット誤差のた
めに、ToF の推定誤差が生じます。SS-TWR法の距離推定誤差の支配的要因は、応答時間 TBreplyです。 

このアプリケーションノートでは、主に SS-TWRについて説明します。 

1.4.2 DS-TWR（Double-Sided Two-Way Ranging）  

SS-TWRと同様、DS-TWR も非対称的な測距法です。すなわち、両方のデバイスで応答時間が一致する必要
はありません。これは、開始方向が異なる 2 つの SS-TWR手順の組み合わせです。 

 

図 1‑6：DS-TWR（Double-Sided Two-Way Ranging） 

DS-TWRの原理を図 1‑6 に示します。全体の手順はデバイス A（タグ）からデバイス B（アンカー）に向け
て開始されます。デバイス Bはデバイス A に応答を送信し、同様にしてデバイス Bがデバイス A に対して
第 2 ラウンドの SS-TWRを開始します。デバイス Bがデバイス A からの応答を受信すると、全体の手順が
完了します。通常は、デバイス Bからデバイス A へのポーリングメッセージと応答メッセージは 1 つのメッ
セージに結合できます。このため、実際には DS-TWRは 3 つのメッセージによって実行されます。 

ToFの推定結果𝑇𝑇𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝＝
𝑇𝑇𝐴𝐴𝐴𝐴𝐴𝐴𝐴𝐴𝐴𝐴𝐴𝐴×𝑇𝑇𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝑑𝑑－𝑇𝑇𝐴𝐴𝐴𝐴𝐴𝐴𝐴𝐴𝐴𝐴𝐴𝐴×𝑇𝑇𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵

𝑇𝑇𝐴𝐴𝐴𝐴𝐴𝐴𝐴𝐴𝐴𝐴𝐴𝐴＋𝑇𝑇𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵＋𝑇𝑇𝐴𝐴𝐴𝐴𝐴𝐴𝐴𝐴𝐴𝐴𝐴𝐴＋𝑇𝑇𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵
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ToF推定値𝑇𝑇𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝がわかれば、距離は SS-TWRの場合と同じ原理で計算できます。すなわち、ToF 推定値に光
速を乗じて距離を求めます。SS-TWRに比べると、ToF推定値に対するクロックオフセットの影響が大幅に
低減されています。DS-TWRの推定誤差は ToFだけに依存し、SS-TWRの場合と異なり TBreply には影響さ
れません [7]。 

2 OTAの基本 

2.1.1 遠方界 

アンテナ周辺の電磁波の伝搬と放射は、3 つの領域に分類されます。すなわち、図 2‑1 に示すように、リア
クティブな近傍界、放射近傍界、遠方界（FF）です。 

 

図 2‑1：アンテナ周辺の電磁波の伝搬領域（出典：Wikipedia） 

基本的に、OTA テスト環境で重要なのは遠方界です。その理由は、この領域では電磁波が主に平面波の特性
を持つとみなされるからです。FF で実行された測定は、測定の信頼度が高くなります。FFとみなすことが
できる最小距離は、フラウンホーファー距離（FHD）𝑟𝑟𝐹𝐹𝐹𝐹と呼ばれています。これは次のように表されます。 

𝑟𝑟𝐹𝐹𝐹𝐹 =
2𝐷𝐷2

𝜆𝜆
 

式 2‑1：フラウンホーファー距離 

ここで、D はアンテナの放射開口部サイズ、λはキャリア周波数の波長を表します。 

アンテナパターン全体が関連する場合には、FHDを考慮する必要があります。ただし、ここで扱う UWBア
プリケーションのように、アンテナ伝送パターンのメインローブだけが重要な場合には、FHDよりも緩い基
準である Derat距離𝑟𝑟𝐷𝐷𝐷𝐷（式 2‑2 を参照）が使用できます。 

𝑟𝑟𝐷𝐷𝐷𝐷 = 𝜆𝜆 �
𝜋𝜋𝜋𝜋
𝜆𝜆
�
0.8633

�0.1673 �
𝜋𝜋𝜋𝜋
𝜆𝜆
�
0.8633

+ 0.1632� 

式 2‑2：Derat 距離 

これを考慮することで、測定性能に悪影響を与えずに、OTA チャンバーのサイズを小さくすることができま
す [8]。 
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このアプリケーションノートで解説する OTA ソリューションでは、測定／フィードアンテナとして、図 3‑8

に示す Vivaldi アンテナが使用されています。アンテナ開口部が 70 mmの Vivaldiアンテナを使用した、UWB

チャネル 5 および 9 の FHDと Derat距離の研究結果を表 2‑1 に示します。これより、Derat距離𝑟𝑟𝐷𝐷𝐷𝐷を考慮す
ることで、FF距離が大幅に短縮されることがわかります。 

 𝒓𝒓𝑭𝑭𝑭𝑭（mm） 𝒓𝒓𝑫𝑫𝑫𝑫（mm） 

UWB チャネル 5（6.4896 GHz） ～210 ～140 

UWB チャネル 9（7.9872 GHz） ～260 ～160 

表 2‑1：UWBチャネル 5 および 9で放射している Vivaldiアンテナの𝑟𝑟𝐹𝐹𝐹𝐹と𝑟𝑟𝐷𝐷𝐷𝐷の比較 

ダウンリンク方向、すなわちテスタから DUT への方向で FF条件が満たされるためには、Vivaldi アンテナと
DUTアンテナの間の距離が Derat距離𝑟𝑟𝐷𝐷𝐷𝐷以上であることが必要です。この条件を満たすことが特に推奨され
るのは、位相偏差を低いレベルに抑える必要がある到来角（AoA）テストシナリオの場合です。 

2.1.2 クワイエットゾーン（QZ） 

クワイエットゾーン Dは、平面波基準からの振幅と位相の偏差が制限される領域を定義します [9]。FHDで
は、表面 D上で振幅差は無視でき、位相偏差Δφは最大 22.5°です [10]。図 2‑2 に、クワイエットゾーン
のサイズを判定する方法を示します。 

 

図 2‑2：クワイエットゾーンのサイズの判定 

クワイエットゾーンのサイズは、テストする DUTのサイズ（あるいはホワイトボックス法の場合は DUT ア
ンテナのサイズ）を制限し、チャンバーのサイズも反映します。クワイエットゾーンが大きいほど、チャン
バーのサイズも大きくする必要があります。このため、大きいアンテナサイズの DUTをテストできます。 

前のセクションで述べたように、DUT アンテナと Vivaldi アンテナの距離が Derat距離𝑟𝑟𝐷𝐷𝐷𝐷以上であれば、ダ
ウンリンク方向のテストは QZ内で行われます。 

これに対して、反対方向（アップリンク）では、DUT から見ると、ホワイトボックス法が採用されていると
仮定した場合（詳細は 2.1.3 を参照）、DUTアンテナのサイズとキャリア周波数がわかれば、Derat距離𝒓𝒓𝑫𝑫𝑫𝑫

を導出できます。導出された𝒓𝒓𝑫𝑫𝑫𝑫がチャンバーのサイズ（CMQ200/CMQ500 では最大 300 mm）を超えなけれ
ば、QZでのアップリンクテストも保証されます。 
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2.1.3 ホワイトボックス法とブラックボックス法 

OTA 環境でのテストには、基本的に、ホワイトボックス法とブラックボックス法の 2 つの方法があります。 

ホワイトボックス法は、DUTのアンテナ位置が正確に知られている場合に適しています。この方法は、研究
開発や製造のアプリケーションで一般的に用いられます。 

一方、ブラックボックス法では、DUT アンテナの位置が不明です。このため、FHDまたは Derat距離の判定
には最大 DUT寸法までを考慮する必要があり、大きいチャンバーが必要になります。ブラックボックス法
は、DUTコンフォーマンステストやサービス段階でのテストで重要な役割を果たします。 

ブラックボックス法に比べると、ホワイトボックス法では OTA チャンバーのフロアスペースを小さくする
ことができます。このアプリケーションノートでテストする DUTは NXP チップセットに基づいており、ア
ンテナの位置があらかじめわかっているので、ここではホワイトボックス法について主に説明します。 

3 UWB OTA テストソリューション 

3.1 システムの概要と準備 

シールドチャンバーCMQ200 HSを使用した UWB OTA テストソリューションを図 3‑1 に示します。別の方法
として、シールドチャンバーCMQ500 を UWBテスト用に使用することもできます。 

 

図 3‑1：CMQ200 HSを使用した R&S UWB OTAテストセットアップ 

このアプリケーションノートでは、2 種類のセットアップ（システムバリアント 1 とバリアント 2）を扱い
ます。これらは、シールドチャンバーに取り付けられた Vivaldi アンテナの数と、それに関連するチャンバー
との RF接続が異なっています。 
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図 3‑2 に示すセットアップのブロック図（システムバリアント 1）では、チャンバー内に Vivaldi 測定アンテ
ナが 1 つあり、RF フィードスルーに接続されています。このセットアップは、UWB Tx、Rx、ToF測定に対
応します。 

 

図 3‑2：システムバリアント 1 のブロック図：Tx、Rx、ToF測定用の RFフィードスルーを備えた UWB OTAテスト環境（1 つの Vivaldi

アンテナ） 

さまざまな衝突角度からの AoA を容易に検証するには、複数の Vivaldi アンテナを備えたテストソリューシ
ョンが推奨されます。この場合、RF経路のスイッチングを可能にするため、図 3‑3 に示すように、RFスイ
ッチ（R&S SP6T）を採用する必要があります（システムバリアント 2）。 

 

図 3‑3：システムバリアント 2 のブロック図：Tx、Rx、ToF、AoA測定用の RFスイッチを備えた UWB OTAテスト環境（複数の Vivaldi

アンテナ） 
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3.1.1 ハードウェア要件 

ソリューションのハードウェア要件は以下のとおりです。 

► 被試験デバイス（3.1.1.1 を参照） 

► 無線機テスタ CMP200（3.1.1.2 を参照） 

► UWB ToFキット R&S CM-Z300A（3.1.1.3 を参照） 

► シールドチャンバーCMQ500 または CMQ200 および高シールド（HS）オプション（3.1.1.4 を参照） 

► リニア偏波 Vivaldi アンテナ CMQ-725A（アンテナキット 5、UWB）（3.1.1.5 を参照） 

► RF接続キット：RFスイッチ CMQ-B744A または RFフィードスルーCMQ-B742A（3.1.1.6 を参照） 

► 制御 PC（Microsoft Windows® OSを搭載した PC） 

3.1.1.1 被試験デバイス（DUT） 

このアプリケーションノートでは、次の NXP評価ボードをテスト用に使用します。 

► UWB Tx、Rx、ToFテスト用には、NXP Trimension™ NCJ29D5 車載用 UWB評価ボード [11]（図 3‑4）。 

 

図 3‑4：NXP Trimension™ NCJ29D5 評価ボード 

このアプリケーションノートで実行される UWBテストは、下の表 3‑1 に示す DUTバージョン情報に基づい
ています。 

UCIバージョン UCI CCCバージョン CCCバージョン ファームウェアバージョ
ン 

デバイスバージョン 

1.0 1.5 0.2.6 2.0.0 22.0 

表 3‑1：DUT のバージョン情報 

► AoA 測定は、次世代 NXP Trimension™ NCJ29D6 チップセットによって可能になる予定です。このチップ
セットは、このアプリケーションノートのリリース時点ではまだ開発中です。 
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3.1.1.2 無線機テスタ CMP200 

 

図 3‑5：複数の切換可能なポートを備えた R&S CMP200 

CMP200 は、ワンボックスのモバイル無線機テスタ（MRT）であり、UWBや 5G FR2 のノンシグナリングモ
ードでのテストに適しています。6～20 GHzの周波数レンジに対応した汎用アナライザと、任意波形発生器
を備えています。周波数レンジ 6～20 GHz の定義済み波形（－100 dBm）の再生をサポートします。1 GHz

帯域幅の 3 つの切り替え可能ポートにより、高速な測定が可能です。 

その他の情報については、こちらのリンク先をご覧ください。 

3.1.1.3 UWB ToFキット R&S CM-Z300A 

UWB走行時間（ToF）キット CM-Z300A は、信号経路全体で一定の群遅延（GD）と挿入損失（IL）を実現す
るアクセサリのセットです。これは、システムのアンテナ遅延校正と経路損失校正のために重要です。詳細
については 3.3.1 と 3.3.2.3を参照してください。 

ToFキット Z300A（図 3‑6）の内容は以下のとおりです。 

► パワースプリッター（モデル：Minicircuit ZFRSC-183+）（付録 A のデータシートを参照） 

► アッテネータ（6 dB、10 dB、20 dB、30 dB） 

► RFケーブル（2×2 m） 

► RFケーブル（1×15 cm） 

https://www.rohde-schwarz.com/us/products/test-and-measurement/wireless-tester-rf-analyzer-generator/rs-cmp200-radio-communication-tester_63493-601281.html
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図 3‑6：UWB ToFキット CM-Z300A 

ToFキット内のアッテネータ（6 dB、10 dB、20 dBまたは 30 dB）は、必要に応じて信号経路に挿入するこ
とで、CMP200 の IFin ポートの受信パワーレベルを調整するために使用できます。これは、安定した信号検
出のために必要な場合があります。ToFテストの際のパワーレベル調整の詳細は、付録 Dに記載されていま
す。 

3.1.1.4 シールドチャンバー 

CMQ200 HSまたは CMQ500 は、UWB OTA テスト用に最適なシールドチャンバーであり、以下の特長を備え
ています。 

► 動作周波数レンジ：CMQ200 HS 0.3～14 GHz/CMQ500 0.7～77 GHz  

► 80 dBを超える高いシールド効果 

► UWB AoA 測定などに必要なマルチアンテナセットアップに最適 
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図 3‑7：OTAチャンバーCMQ200 HS（上）および CMQ500（下）の正面図と背面図  

一般的に、OTA シールドチャンバーは、お客様のテストニーズに応じて、ドアの開閉機構、テーブルレイア
ウト、フィクスチャレイアウト、フィードスルー（RF、USB、その他の接続）などの柔軟な構成が可能で
す。チャンバー構成の詳細については、 [12]を参照するか、R&S営業担当者までお問い合わせください。 

このアプリケーションノートでは、チャンバー内の DUTの電源供給と制御に USBを使用します。そのた
め、アクセサリとして USBフィードスルーが必須です。それに加えて、RFフィードスルーまたは RFスイ
ッチ（3.1.1.6 を参照）を装備する必要があります。 

R&Sウェブサイトの詳細情報：CMQ200 製品ページおよび CMQ500 製品ページ 

3.1.1.5 アンテナキット 

アンテナキット（CMQ-B725A）には、OTA チャンバー内の UWBテストのための標準化されたコンポーネン
トが含まれています。これを使用すれば、RF ケーブルの長さの違いに起因する測定の不確かさを除去でき
ます。キットには、UWB 測定に必要な周波数レンジに対応したアンテナが含まれています。 

含まれるコンポーネントは次のとおりです。 

► Vivaldi アンテナ 

2.4～18 GHzの周波数レンジに対応し、指向性パターンと高い利得を備えた単一のリニア広帯域 UWBア
ンテナ。図 3‑8 に、オープン開口部サイズが 70 mm の Vivaldi アンテナを示します。 

 

図 3‑8：開口部サイズ 70 mmの R&S TS-F24-V2（Vivaldiアンテナ） 

https://www.rohde-schwarz.com/us/products/test-and-measurement/antenna-test-systems-and-ota-chambers/rs-cmq200-shielding-cube_63493-683264.html
https://www.rohde-schwarz.com/us/products/test-and-measurement/antenna-test-systems-and-ota-chambers/rs-cmq500-shielding-cube_63493-807406.html
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► Vivaldi アンテナと OTA チャンバーの RFスイッチまたは RFフィードスルーを接続する 55 cmの RFケ
ーブル 

► Vivaldi アンテナ固定アクセサリ：3Dフィクスチャおよび 45°アダプター 

3.1.1.6 RF接続キット 

2 種類の RF接続キット（RFフィードスルーまたは RFスイッチ）が選択可能です。どちらの RF接続キット
も、周波数レンジの上限は 40 GHzです。 

1 つの Vivaldi アンテナは、チャンバー内の RFフィードスルー（CMQ-B742A）を通じて接続されます（シス
テムバリアント 1）。 

オプションの RFスイッチ RS SP6T（CMQ-B744A）（図 3‑9 を参照）が必要なのは、AoA 測定などのために
複数の Vivaldi アンテナを OTA チャンバー内に取り付ける必要がある場合です（システムバリアント 2）。 

 

図 3‑9：RFスイッチモジュール SP6T 

RFスイッチ RS SP6Tには、6 つのスイッチポートがあります。正面から見たポート番号の配置を図 3‑10に
示します。 

 

図 3‑10：RFスイッチ（SP6T）の正面から見たポート番号の配置 

マルチアンテナセットアップの場合、RFスイッチ位置の変更は、WMTソフトウェアに完全に統合された
CMQのリモートインタフェースを通じて制御されます。これを可能にするには、RFスイッチポートと
Vivaldi アンテナの接続が、テスト構成ファイル testconfig.iniで正しく設定されている必要があります。 

図 3‑11 に構成の例を示します。3 つの Vivaldi アンテナが RFスイッチに接続され、スイッチは CMP200 の
Port1.IFin ポートに接続されます。このコンスタレーションでは、testconfig.iniファイルのニーモニック
「relay」の最後の数字によって、Vivaldi アンテナが接続される RFスイッチポートの番号が決まります。図
3‑12 に、Vivaldi アンテナ 1（中央のアンテナ）に対応する testconfig.iniファイルの設定を示します。 

1 2 

3 

4 5 

6 



 

Rohde & Schwarz | Application Note Automotive UWB Device Testing Over the Air  24 

 

  

 

図 3‑11：RFスイッチポート番号の設定 

 

図 3‑12：testconfig.iniのリレー設定 

testconfig.iniファイルの詳細は、付録 Cに記載されています。 

3.1.2 ソフトウェア要件 

この章では、テストソリューションのソフトウェア要件の概要を示します。 

3.1.2.1 CMP200ファームウェア 

3.1.2.1.1 一般事項 

CMP200 には、CMP200 ファームウェアをインストールする必要があります。これは、信号の発生と解析を
制御し、ウェブベースの GUIである CMsquaresを通じた測定器へのリモートアクセスを可能にします。ライ
センスに関しては、UWB テスト用には以下のライセンスが必要です。 

► UWB測定オプション KM300 

► WinIQSIM2 任意波形発生オプション KW300（波形ファイルの発生用） 

► スマートチャネルソフトウェアオプション CMP-K103を使えば、3 台の DUTの並列テストによりテス
ト時間を短縮可能（オプション） 

 

接続識別子 

CMP200 のコネクタ名  

リレー位置（最後の数字が RFスイッチポート番号に対応）  



 

Rohde & Schwarz | Application Note Automotive UWB Device Testing Over the Air  25 

 

  

図 3‑13 は、CMP200 の CMsquares IVによる UWB測定を表します。CMsquaresにアクセスするには、任意の
PCでウェブブラウザーのアドレスフィールドに CMP200 の IPアドレスを入力します。ただし、PCと
CMP200 は同じ IPサブネット上に存在する必要があります（3.1.4 の IP設定を参照）。 

 

図 3‑13：CMP200 の CMsquaresでの UWB測定 

3.1.2.1.2 インストール 

GlorisV（https://gloris.rohde-schwarz.com/）をチェックして、CMP200 に最新のソフトウェアがインストール
されていることを確認します。最新でない場合は、以下の手順でソフトウェアをアップデートします。 

1. CMP200 ソフトウェアのインストーラー（setup_cmp200_xyzVI.exe）を Glorisから制御 PCにダウンロー
ドします。 

2. 制御 PC上でインストーラーをリモート実行し、以下の手順を実行します。 

a) インストーラーをダブルクリックすると、ソフトウェアディストリビューターが起動します。そこ
で "Remote Installation" を選択し、"Next" を押して続行します（図 3‑14）。これにより、ソフトウ
ェアをリモートで CMP200 にインストールできます。 

                                                 

 

IV CMsquaresは、CMP200 のウェブベースのグラフィカルユーザーインタフェース（GUI）を表します。 

V Glorisは R&Sのセルフサービス型カスタマーポータルです。 

VI xyzは CMP200のソフトウェアバージョンに置き換えます。 

https://gloris.rohde-schwarz.com/
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図 3‑14：ソフトウェアディストリビューターの起動 

b) ライセンス契約に同意し、"Next" を押して続行します（図 3‑15）。 

 

図 3‑15：ライセンス契約への同意 

c) インストールするパッケージをすべて選択し、"Next" を押して続行します（図 3‑16）。 

 

図 3‑16：インストールするパッケージの選択 

d) ソフトウェアのリモートインストール先として、"Device List" で CMP200 ユニットを選択し、
"Install" を押してインストールプロセスを開始します（図 3‑17）。 
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図 3‑17：CMP200 ユニットの選択 

e) しばらく待つと、"Status" 列に "Ready: see report for details" というテキストが表示されます。
"Report" をクリックして、インストールが成功したことを確認します。 

f) "Exit" をクリックして、ソフトウェアディストリビューターを終了します。 

g) CMP200 を再起動します。 

h) CMP200 が起動し、ファームウェアアップデートプロセスが完了したら、CMP200 の IPアドレスを
制御 PCのブラウザーに入力すると（セットアップの IP設定については 3.1.4 を参照）、CMP200

の GUI（CMsquares）がロードされます（図 3‑18）。 

 

図 3‑18：CMsquaresのロード 
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3.1.2.2 WinIQSIM 

3.1.2.2.1 一般事項 

WinIQSIM は、Windowsベースの信号発生ソフトウェアであり、UWB波形を含むデジタル変調信号波形を作成
します。作成された波形ファイルを使用すれば、同じテスト信号設定で再現性のあるテストを実行できま
す。 

ここに示すアプリケーションでは、WinIQSIM は、UWBテスト信号を UWBレシーバーテスト用の波形ファイ
ルの形式で制御 PC上に作成します。その後、波形ファイルは CMP200 に転送されて再生されます。 

図 3‑19 に WinIQSIM のメイン GUIウィンドウを示します。 

 

図 3‑19：WinIQSIM のメイン GUIウィンドウ 

3.1.2.2.2 インストール 

1. https://www.rohde-schwarz.com/us/software/winiqsim2/にアクセスして最新の WinIQSIM ソフトウェアを
入手し、制御 PC にインストールします。ソフトウェアは、Windowsインストーラー形式で配布されて
います。 

2. WinIQSIM ソフトウェアを起動し、バックグラウンドで動作させておきます（WMTが WinIQSIM を制御し
ます）。これが必要なのは、新しい波形ファイルを作成する場合だけです。必要な波形ファイルがすで
に CMP200 上に存在する場合、WinIQSIM は不要なので、バックグラウンドで動作させておく必要はあ
りません。 

https://www.rohde-schwarz.com/us/software/winiqsim2/
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3.1.2.3 Wireless Automated Testing（WMT）ツール 

3.1.2.3.1 一般事項 

WMTは Python ベースのソフトウェアソリューションであり、5G NR、Wi-Fi、Bluetooth、UWB（UWB Tx、
Rx、ToF、AoA テストを含む）などのチップセットおよびモジュールの RFテストに使用されます。このソ
リューションは、量産テストや研究開発アプリケーション向けに設計されています。モジュラーアーキテク
チャーにより柔軟な統合が可能で、製品の市場投入までの時間を短縮できます。 

 

図 3‑20：WMTのアーキテクチャー 

図 3‑20 に示すように、WMTは制御 PC にインストールされ、測定器（CMP200 など）の制御、OTA チャン
バー（CMQ200/CMQ500 など）との通信、DUTの制御（UWB DUT との UCI通信）、テストケースの実行、
リミットチェック、レポート収集の機能を果たします。 

制御部分は次の機能を備えています。 

► SCPI リモートインタフェース経由での TCP/IPの Rawソケット接続を使用した CMP200 の制御 

► CMQ200/CMQ500 チャンバーの場合、AoA テストなどのマルチアンテナのケースで使用する測定アンテ
ナを選択するために、RF スイッチ位置の設定が必要です。これは、リモートインタフェース経由で
TCP/IP の Rawソケット接続を使用して制御されます。 

► 制御インタフェース（COM ポート）を通じた標準の FiRa または NXP独自 UCI コマンド通信による
DUTの制御 

WMTでは、WMTテストプランエディターと WMTテストランナーの 2 種類の GUIが提供されています。以下
の部分では、テストプランエディターとテストランナーを、それぞれ WMTテストプランエディターおよび
WMTテストランナーと同じ意味で使用します。 
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テストプランエディター（図 3‑21）では、名前からわかるように、テストプランの新規作成や、既存のテス
トプランの変更が可能です。各テストプランには、それぞれ固有のパラメータ設定を持つ複数のテストルー
チンを含めることができます（詳細については 3.3 および 3.4 を参照）。 

 

図 3‑21：WMTテストプランエディターの GUI 

テストランナー（図 3‑22）は、選択したテストプランのテスト実行と、複数 DUTの並列テストのための環
境を提供します。各テストプランが実行された後、テストレポートを調べることができます。必要な場合、
テスト実行に関連するデバッグログをテストランナーからチェックできます。 

 

図 3‑22：WMTテストランナーの GUI 

その他の情報については、こちらのリンク先をご覧ください。 

https://www.rohde-schwarz.com/us/products/test-and-measurement/wireless-communications-testers-systems/wireless-communication-testers-systems/wireless-manufacturing-test_253261.html
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3.1.2.3.2 インストール 

WMTソフトウェアは、NXP Trimension™ NCJ29D5 などのチップ向けの Windows インストーラー形式で配布さ
れています。インストーラーNXP_NCJ29D5D_UCI_Custom-Custom.1.0.0.7.msiを実行し、以下のインストール
手順を実行します。 

1. ようこそページで "Next" ボタンを押します。 

 

図 3‑23：ようこそページ 

2. "Next" ボタンを押してライセンス契約に同意します。 

 

図 3‑24：ライセンス契約への同意 

3. 制御 PC上のインストールフォルダーを指定し、"Next" ボタンを押して続行します。 
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図 3‑25：インストール先フォルダーの指定 

4. "Install" ボタンを押してインストールを開始します。 

 

図 3‑26：インストールの確認 

5. インストールプロセスが完了するまで待ち、"Finish" ボタンを押して終了します。 

 

図 3‑27：インストールの完了 
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インストールが成功すると、WMTインストールフォルダーの下にフォルダー構造が作成されます（図 3‑28

を参照）。そこから、テストプランエディター（testplan_editor.exe）とテストランナー
（testrunner_gui.exe）を起動できます。インストールフォルダーの下にテストプランを保存するためのサ
ブフォルダー "testplans" がない場合は、作成します。 

  

図 3‑28：インストールフォルダーの下のフォルダー構造 

3.1.2.4 DUT USBドライバー 

評価ボード NXP Trimension™ NCJ29D5 用の USBドライバーを制御 PC にインストールする必要があります。
https://www.pemicro.com/opensda/にアクセスして、USBドライバーのインストーラー
（PEDrivers_install.exe）を入手します。 

3.1.3 配線 

テストセットアップのシステム配線を以下の図 3‑29、図 3‑30、図 3‑31 に示します。 

https://www.pemicro.com/opensda/
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図 3‑29：配線済みのセットアップの正面図  

UWB ToFキットの RFケーブル  

DUT電源および UCIコマンド用
の USBケーブル  

USBフィードスル
 

制御 PC 

CMP200 

CMQ500 
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図 3‑30：配線済みのセットアップの背面図 

     

図 3‑31：パワースプリッターの配線と CMP200の RFポートとの接続 

RFスイッチ 

RS232 ケーブル 

（RFスイッチCMQの R1 ポート）  

LANケーブルチャンバ
 

LANケーブル CMP200 

UWB ToFキットの
パワースプリッター 

UWB ToFキットの 

15 cm RFケーブル 

UWB ToFキット
の RFケーブル 

Port SRFスイッチ／フィードスルー 

ポ ト 1CMP IF O t

 

ポート 1  CMP IFout ポート

 

 ポート 2  CMP IFin ポート
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3.1.4 IP設定 

CMP200 と PCの IP アドレスは、同じ IP セグメントに属する必要があります。そのためには、DHCP を使用
する方法と、スタティック IP割り当てを行う方法があります。 

► DHCPによる IPアドレスの自動割り当て 

CMP200 と制御 PCの両方が接続するネットワークで DHCPサーバーが動作しており、接続されたデバイス
に IPアドレスを自動的に割り当てます。これは、CMP200 と制御 PCが企業ネットワークに接続される場合
に一般的なケースです。 

ただし、CMQ200/CMQ500チャンバーの IPアドレスは 192.168.178.41 に固定されています。多くの場合、制
御 PCと CMP200 の IPアドレスは、DHCP サーバーによってこれとは異なる IP サブネット（例：サブネッ
ト 10.202.1.*）に割り当てられます。この展開シナリオでは、制御 PC が CMP200 とチャンバーの機能を制御
するために 2 つのネットワーク上で動作する必要があるため、図 3‑32 に示すように制御 PCに 2 つのネット
ワークインタフェースが必要になるのが普通です。 

 

図 3‑32：CMP200 と制御 PCの IPアドレスが DHCPサーバーによって自動的に割り当てられる場合、制御 PCに 2 つのネットワークイ
ンタフェースが必要 

► IPアドレスの手動割り当て（スタティック IP） 

CMP200 と制御 PCの両方にスタティック IPアドレスを設定します。これは、セットアップがスタンドアロ
ンで動作する場合に一般的なケースです。 

先に説明した自動割り当ての場合と異なり、IP アドレスを手動で設定する場合、ユーザーは、制御 PC と
CMP200 の両方の IP アドレスを、チャンバーの固定 IPアドレスと同じサブネット（例：192.158.178.*）に属
するように設定できます。そのため、制御 PCのネットワークインタフェースは 1 つで十分です。 

CMP200 の IPアドレスの手動設定の詳細については、 [13]の第 6.8.1 章を参照してください。 

ヒント： 

CMP200 の IPアドレスは、再起動が成功した後で、測定器フロントパネルの LED ディスプレイで直接読み
取ることができます。 
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3.1.5 CMQ200/CMQ500内の DUT配置 

前に 2.1.3 で述べたように、このアプリケーションノートで扱うのは、OTA チャンバー内のホワイトボック
ス法です。すなわち、DUT アンテナの物理的位置は知られていると仮定します。 

OTA チャンバー内の測定では、Vivaldi 測定アンテナと DUTのアンテナの間の自由空間距離を知ることがき
わめて重要です。この距離は、信号の経路損失と伝搬遅延に影響します（校正の詳細については 3.3 を参
照）。 

CMQ200/CMQ500 では、表 3‑2 に示すように、テーブルレイアウトを内部式と引き出し式の 2 種類から選択
できます。テーブルレイアウトのタイプは、発注時のチャンバー構成に含まれています。 

テーブルレイアウト オプション 説明 注記 

内部テーブルレイアウト R&S®CMQ-B701A テーブルは CMQ内部に取り付け  テーブルの高さはユーザー定義
可能 

引き出し式テーブルレイアウト R&S®CMQ-B702A テーブルは CMQ前面の引き出し
に取り付け 

取り付け位置は 2 種類の固定位
置から選択  

表 3‑2：CMQのテーブルレイアウト 

引き出し式テーブルレイアウト（図 3‑33 を参照）の場合、テーブルの取り付け位置を、2 種類の固定位置
（下の位置 1 と上の位置 2）から選択できます。2 つの位置は 135 mm離れています。さらに、Vivaldi アンテ
ナをチャンバー内に取り付けるために、R&Sから購入したアンテナ固定アクセサリ（アンテナキット 3.1.1.5

を参照）を使用する場合、引き出し式テーブル位置 1 と Vivaldi アンテナの間の距離は 313 mmに固定されま
す（図 3‑34 を参照）。これらの基準値は、後で Vivaldi アンテナと DUTの間の自由空間距離を求めるために
使用できます。 

テーブルはドアに取り付けられるため、DUT のロード／アンロードに便利です。このため、例えば製造現場
でロボットアームを使用する場合などに有利です。 

 

図 3‑33：CMQ200/CMQ500 の引き出し式テーブルレイアウトでの 2種類の固定位置 
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図 3‑34：引き出し式テーブル位置 1と Vivaldiアンテナの間の距離（313 mm） 

一方、内部テーブルレイアウトでは、テーブルはチャンバー内の任意の高さ位置に取り付けることができま
す。これにより、当然、DUT位置の自由度が高まります。 

どちらのテーブルレイアウトを選択した場合でも、自由空間距離は求める必要があります。これは、Vivaldi

測定アンテナの開口部と DUTのアンテナの間の距離です。CMQ200/CMQ500 のクレードル（スケーラーの
付いた固定フレーム）を使用すれば、Vivaldi 測定アンテナと DUT アンテナを Y 軸に関して同じ平面上に配
置できます。X軸上の自由空間距離は、クレードルを使用し、DUTのアンテナの幾何学的状況を考慮するこ
とで算出できます。DUT と Vivaldi アンテナの開口部の間の X軸上の最小距離は、表 2‑1 で示した Derat距離
以上である必要があります。例えば、チャネル 5 をテストする場合、最低 14 cm離れている必要がありま
す。 

図 3‑35（内部テーブルレイアウト）は、AoA テストを含むすべての UWBテストでの推奨される DUT位置と
3 つの Vivaldi アンテナの位置を示します。Vivaldi アンテナの DUT アンテナに対する衝突角は、アンテナアダ
プターを使うことで、22.5°のステップ幅で調整できます。図 3‑36 に示す例では、アンテナがアンテナアダ
プターで 45°に固定されています。 
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図 3‑35：CMQ200 チャンバーでの UWB AoAテスト用の UWB DUTおよび測定アンテナ（Vivaldi）の配置 

 

図 3‑36：アダプターによる Vivaldiアンテナの角度調整（45°） 

Vivaldi アンテナ
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3.2 テスト手順 

3.2.1 WMTテストプランエディターの操作 

テストプランエディターで新規 UWBテストプランを作成するか、既存のテストプランを設定します。 

1. WMTインストールフォルダーで、testplan_editor.exeをダブルクリックしてテストプランエディター
を起動します。 

2. テストプランエディターでは、新規テストプランの作成（メインメニュー > "File" > "New"…）や、既
存のテストプランの確認または変更（メインメニュー > "File" > "Open"…）を実行できます。図 3‑37 を
参照してください。 

テストプランには、トランスミッター、レシーバー、ToFテスト用のテストルーチンを含めることがで
きます。 

  

図 3‑37：テストプランエディターで新規テストプランを作成／既存のテストプランを開く 

テストプランの例を以下の図 3‑38 に示します。校正および検証ルーチンの作成とその設定についての詳細
は、第 3.3.2 章と第 3.4 章に記載されています。 
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図 3‑38 ：テストプランエディターでの UWB テストプランの例 

3.2.2 WMTテストランナーの操作 

テストランナーでテストプランを実行するには、以下の手順を実行します。 

1. WMTインストールフォルダーで、testrunner_gui.exeをダブルクリックしてテストランナーGUI を起
動します。 

2. テストランナーGUIでは、テスト構成ファイル（testconfig.ini）を使用可能にする必要があります。
図 3‑39 に示すように、これにはテストランナーのメインメニュー > "Edit" > "Settings" からアクセスで
き、3 つの操作オプションが利用できます。 

─ Edit：テスト構成ファイルをテキストエディターで編集します。 

─ Open：WMTインストールフォルダーのサブフォルダー\etcにある既存のテスト構成ファイルを開
きます。 

─ New：定義済みの構成構造を持つ新規テスト構成ファイルを作成します。 

 

図 3‑39：テストランナーでのテスト構成ファイル "testconfig.ini" へのアクセス 

3. "testconfig.ini" ファイルを設定します。図 3‑40に最も重要な設定を示します。 

─ テストプランのアクティブ化（一度にアクティブ化できるテストプランは 1 つだけです。アクティ
ブ化するには、対象のテストプランの前にあるセミコロン記号を削除します） 

─ 制御 PCの DUT制御（UCI 通信）用の仮想シリアルポート（例：COM3）の指定 

─ CMP200 の IPアドレスの入力 

─ 必要な場合、任意発生器の有効化 

─ 接続の定義（名前、CMP200 の物理コネクタ、関連する接続の FDCVII） 

                                                 

 

VII FDC＝Frequency Dependent Correction（周波数依存補正） 

 
 

 1 2 

3 
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図 3‑40："testconfig.ini" ファイルの最も重要な設定 

図 3‑40 の設定に関するヒント 

─ "testconfig.ini" ファイルに入力された DUT制御ポート（仮想シリアルポート）は、Windows OS

のデバイスマネージャーで確認できます。例えば、図 3‑41 では COM3 ポートが割り当てられてい
ます。 

─ 測定器の IPアドレスは、CMP200 のフロントパネルにある LEDディスプレイから容易に読み取る
ことができます。 

 

 

 

 

 

 
 
 

 

 

アクティブなテスト
 

検証用の DUT制御ポート 

校正用の DUT制御ポート 

CMP200 の IPアドレス 

波形ファイル作成のために WinIQSIM を有効化 

接続の名前 

CMP200 の物理コネクタの名前 

この接続に対する FDCの名前 

FDCの名前 

周波数と経路損失 
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図 3‑41：Windowsデバイスマネージャーでの割り当てられた DUT制御ポートの確認  

4. "Save" ボタン（図 3‑40）を押して "testconfig.ini" の変更を確認し、設定ウィンドウの "Save" ボタ
ン（図 3‑39）を押して終了します。 

5. テストランナーGUIのメインウィンドウの "Run" ボタンをクリックして、テストプランを実行します
（図 3‑42 を参照）。テストプラン実行の進捗状況はテストランナーGUI上で更新され、実際のテスト結
果は GUIの "DUTxVIII" タブで確認できます。 

 

図 3‑42：WMTテストランナーの概要 

                                                 

 

VIII xは DUT識別子のサフィックスです。サフィックスは新しい DUTインスタンスが追加されるたびに 1ずつ増えます。 
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6. テストプラン実行が完了すると、テスト結果全体が "DUTx" に表示されます（図 3‑43 を参照）。必要
な場合、"View Log" チェックボックスをオンにして、詳細ログを確認します（図 3‑44）。これはデバッ
グの際に非常に役立ちます。 

 

図 3‑43：テストランナーの結果ページ 

 

図 3‑44：テストランナーのログ表示 

7. 必要な場合、WMTインストールフォルダーの下のサブフォルダーetc/results/DUTx/および
etc/logs/DUTx/に移動して、保存されているテスト結果ファイルとログファイルを取得します。 
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3.3 校正 

この章では、校正について、OTA テストシステムの経路損失校正とデバイス校正の 2 つの側面から説明しま
す。 

3.3.1 OTAテストシステムの経路損失校正 

OTA テストシステムの経路損失校正は、パワーレベル補正による正確な測定を可能にするために必要です。
この校正で考慮されるのは、信号伝搬チェーンを構成するすべてのコンポーネントによって発生する挿入損
失（IL）と、チャンバー内の自由空間での信号パワーレベル損失です。後者は自由空間経路損失（FSPL）と
呼ばれ、通常は OTA システムのパワー損失の支配的要素です。 

3.1 ですでに述べたように、ここでは 2 種類のシステムバリアントを考慮します。すなわち、RFフィードス
ルーを含むチャンバー（バリアント 1）と、RFスイッチを含むチャンバー（バリアント 2）です。図 3‑45 に
示すように、どちらのセットアップバリアントの場合でも、経路損失（PL）には、既知のコンポーネント
（ToFキット、RFフィードスルー/RFスイッチ、Vivaldi アンテナ、3.1.1.3、3.1.1.5、3.1.1.6 を参照）による固
定 IL部分と、距離と周波数に依存する FSPLが含まれます。 

 

図 3‑45：経路損失全体の概要図（信号経路の固定挿入損失と、距離と周波数に依存する自由空間損失の合計）  

表 3‑3 のルックアップテーブルは、ToFキットのアッテネータ（3.1.1.3 を参照）を信号経路に使用しない場
合の、CMP200 の出力ポートから DUT アンテナまでの全経路損失を示します。アッテネータを信号経路に接
続する必要がある場合には、対応する追加の経路損失（6、10、20 または 30 dB）を、ルックアップテーブ
ル内の経路損失に加算する必要があります。 

OTAセットアップ 周波数 さまざまな自由空間距離での CMP出力から DUTまでの経路損失  

  5 cm 10 cm 15 cm 20 cm 25 cm 30 cm 

バリアント 1 

（RFフィードスル
ー）  

6.5 GHz －30.0 dB －33.6 dB －36.1 dB －38.1 dB －39.8 dB －41.4 dB 

8 GHz －32.1 dB －35.6 dB －38.1 dB －40.1 dB －41.6 dB －42.9 dB 

バリアント 2 

（RFスイッチ）  

6.5 GHz －30.2 dB －33.8 dB －36.3 dB －38.3 dB －40.0 dB －41.6 dB 

8 GHz －32.4 dB －35.9 dB －38.4 dB －40.4 dB －41.9 dB    －43.2 dB 

表 3‑3：アッテネータを挿入しない状態での 6.5 GHzおよび 8 GHzでの CMP出力ポートから DUT までの全経路損失 
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ルックアップテーブルを使用すれば、システムの信号経路損失をすばやく簡単に知ることができます。全経
路損失を決める要因としては、OTA セットアップのバリアント（RFフィードスルーか RFスイッチか）、動
作周波数、Vivaldi アンテナと DUTアンテナの間の自由空間距離があります。例えば、RFスイッチ使用のセ
ットアップ、動作周波数 6.5 GHz、Vivaldi アンテナと DUTの距離 15 cmの場合、該当する PL 値は－36.3 dB

です。 

PL 値は、WMTでテストを実行する前に、テストプラン構成ファイル testconfig.iniで設定する必要があり
ます（詳細については 3.2 または付録 Cを参照）。図 3‑46 は、6.5 GHzで 36.3 dBIXの PL が、FDC_ANT1_RX

と FDC_ANT1_TX の両方の周波数依存補正に適用されることを示しています。これらは、CMP200 の物理コネ
クタ Port1.IFOutと Port1.IFIn に適用される FDC です。これらのコネクタを識別するコネクタ名は、それぞれ 

"ANT1_RX" と "ANT1_TX" です。テストプランエディターで設定する必要があるのは、識別子となるコネク
タ名（例：ANT1_RX、ANT1_TX）だけです。 

 

図 3‑46：WMTでの testconfig.iniファイルへの経路損失の入力 

3.3.2 デバイス校正ルーチン 

UWBデバイスに対しては、検証前に内部校正ルーチンを実行する必要があります。これには、水晶振動子校
正、Txパワー校正、ToF校正があります。 

3.3.2.1 水晶振動子（XTAL）校正 

水晶振動子（XTAL）校正は、DUTの中心周波数オフセット（CFO）誤差を仕様限界内に収めるために必要
です。これはチャネルに依存しません。図 3‑47 に、水晶振動子校正ルーチンの作成手順と、テストプランエ
ディターでの重要な関連設定を示します。 

                                                 

 

IX testconfig.iniファイルでは経路損失値を正の値で入力します。 

 
 

 

 

 

 

 

 
 

 

36.3 dB PL@6500 MHz：FDC_ANT1_RX 

36.3 dB PL@6500 MHz：FDC_ANT1_TX 



 

Rohde & Schwarz | Application Note Automotive UWB Device Testing Over the Air  47 

 

  

 

図 3‑47：テストプランエディターでの XTAL校正ルーチンの作成と設定 

1. テストプランエディターの規格選択フィールドで、"Calibration" を選択します。 

2. "Add" を押して校正ルーチンを追加します。 

3. 校正モードとして "Xtal" を選択します。 

4. 水晶振動子の偏差リミットを定義します。特に指定がない限り、デフォルト値の 0.5 ppmをそのまま使
用してかまいません。 

5. 校正ルーチン名を指定します（例："XTAL Calibration CH5"）。 

6. Tx方向と Rx方向の両方のコネクタのコネクタ名を指定します（例："ANT1_TX"、"ANT1_RX"）。指定
したコネクタ名は、testconfig.iniファイルに記述されているものと一致する必要があります（FDC

とコネクタの対応については 3.3.1 を参照）。 

7. メインメニューバーで、"File" > "Save/Save As"…を選択して、テストプランを保存します。 

テストランナーで XTAL校正ルーチンを実行すると（3.2.2 を参照）、校正結果が図 3‑48 のように表示されま
す。ここでは、FreqErrorPPM が 0.06 ppmと表示されており、このルーチンで定義されたリミットの 0.5 ppm

を下回っています。DUT のトリムパラメータ FREQ_DIFFは、対応する XTALトリム値 418,09 Hzによって更
新されます。 
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図 3‑48：テストランナーでの XTAL校正結果 

3.3.2.2 パワー校正 

FCCでは、UWBデバイスの送信パワーの最大パワースペクトラム密度を－41.3 dBm/MHz未満にすることを
義務付けています 。UWB DUTがこのパワー要件を満たすことを確認するため、パワー校正ルーチンが必要
です。校正は各チャネルおよびアンテナに対して実行する必要があります。 

 

図 3‑49：テストプランエディターでの Txパワー校正ルーチンの作成と設定 

1. テストプランエディターの規格選択フィールドで、"Calibration" を選択します。 

2. "Add" を押して校正ルーチンを追加します。 

3. 校正モードとして "Power" を選択します。 

4. UWBチャネルを選択します（例：チャネル 5）。 

5. パワー校正モードとして "MaxSpectralDensityPower" を選択します。 

6. パワー偏差ターゲットを定義します（例：デフォルト値の 0.5 dBm/MHz）。 
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7. パワーターゲットとして "-41.8 dBm/MHz" を指定します（ここではワーストケースを考慮していま
す。Txパワーが FCCのリミットである－41.3 dBm/MHzを満たすためには、0.5 dBm/MHzの最大パワー
偏差を考慮する必要があるからです）。 

8. 校正ルーチン名を指定します（例："Tx Power Calibration CH5"）。 

9. Tx方向と Rx方向の両方のコネクタのコネクタ名を指定します（例："ANT1_TX"、"ANT1_RX"）。指定
したコネクタ名は、testconfig.iniファイルに記述されているものと一致する必要があります（FDC

とコネクタの対応については 3.3.1 を参照）。 

10. メインメニューバーで、"File" > "Save/Save As"…を選択して、テストプランを保存します。 

Txパワー校正ルーチンをテストランナーで実行すると（3.2.2 を参照）、校正結果が図 3‑50 のように表示さ
れます。ここでは、トリムパラメータ TX_POWER_DIFF（受信した Txパワーと予想 Txパワーの差）の値と
して 12 が DUTに対して設定されています。NXP® UCI仕様 [14]によれば、このトリム値は＋3 dB に対応し
ます。 

 

図 3‑50：テストランナーでの Txパワー校正結果 

3.3.2.3 ToF校正 

精密な測距を行うには、UWBデバイスのアナログアンテナフロントエンドとデジタル処理ユニットの間の過
大な内部時間遅延すなわちアンテナ遅延を測定し、以後の測距セッションで補正する必要があります。アン
テナ遅延は、Tx と Rxの両方向で発生します。図 3‑51 に示されている DUT側の𝑇𝑇𝑇𝑇𝑇𝑇と𝑇𝑇𝑅𝑅𝑅𝑅を算出する必要が
あります。それこそがこのセクションで説明する ToF校正の役割です。 

 

図 3‑51 ：アンテナ遅延校正および ToF検証の原理（表 3‑4 を参照）  
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名称 説明 

𝒕𝒕𝟎𝟎 ポーリングパケットの発信時刻  

𝒕𝒕𝟏𝟏 ポーリングパケットがスプリッターに到着した時点の時間インスタンス 

𝒕𝒕𝟐𝟐 ポーリングパケットがスプリッターから CMP200 に返された時点の時間インスタンス 

𝒕𝒕𝟑𝟑 DUT 応答パケットがスプリッターに到着した時点の時間インスタンス 

𝒕𝒕𝟒𝟒 DUT 応答パケットが CMP200 に到着した時点の時間インスタンス 

𝑻𝑻𝒕𝒕𝒕𝒕 CMP200からスプリッターまでのポーリングパケットの伝搬時間（t1－t0） 

𝑻𝑻𝒓𝒓𝒓𝒓 スプリッターから CMP200に返されたポーリングパケットの伝搬時間（t2－t1） 

𝑻𝑻𝑹𝑹𝑹𝑹𝑹𝑹𝑹𝑹𝑹𝑹 t4と t2の時間差（t4－t2）。これは t3と t1の時間差（t3－t1）に等しくなります。 

𝑻𝑻𝒕𝒕𝒕𝒕𝒕𝒕 走行時間 

𝑻𝑻𝑹𝑹𝑹𝑹𝑹𝑹𝑹𝑹𝑹𝑹 DUT 応答時間（TRX＋Tre＋TTX） 

𝑻𝑻𝑹𝑹𝑹𝑹 DUT のレシーバー経路の内部アンテナ遅延 

𝑻𝑻𝑻𝑻𝑻𝑻 DUT のトランスミッター経路の内部アンテナ遅延 

𝑻𝑻𝒓𝒓𝒓𝒓 DUT の内部パケット処理時間 

表 3‑4：アンテナ遅延校正のタイミング（図 3‑51 を参照） 

アンテナ遅延校正の原理を以下に説明します。 

図 3‑51 に示すように、𝑇𝑇𝑅𝑅𝑅𝑅𝑅𝑅𝑅𝑅𝑅𝑅は、𝑡𝑡2にスプリッターから返されたポーリングパケットの RMARKERと、𝑡𝑡4に
CMP200 のアナライザ側に到着した DUTの応答パケットの間のタイムインターバルを表します。また、
𝑇𝑇𝑅𝑅𝑅𝑅𝑅𝑅𝑅𝑅𝑅𝑅は、スプリッターでの𝑡𝑡3と𝑡𝑡1の時間差でもあります。スプリッターから CMP200 までのパケットの伝

搬時間も同じなので、𝑇𝑇𝑅𝑅𝑅𝑅𝑅𝑅𝑅𝑅𝑅𝑅＝𝑡𝑡3－𝑡𝑡1＝𝑡𝑡4－𝑡𝑡2となります。したがって、ToF の計算と検証の際には、スプリ
ッターの右側だけが時間計算に用いられます。 

式 3‑1 

𝑇𝑇𝑅𝑅𝑅𝑅𝑅𝑅𝑅𝑅𝑅𝑅 = 𝑇𝑇𝑟𝑟𝑟𝑟 + 2𝑇𝑇𝑡𝑡𝑡𝑡𝑡𝑡 + 𝑇𝑇𝑅𝑅𝑅𝑅 + 𝑇𝑇𝑇𝑇𝑇𝑇 

ここで、𝑇𝑇𝑅𝑅𝑅𝑅＋𝑇𝑇𝑇𝑇𝑇𝑇は、双方向アンテナ遅延を表します。 

式 3‑2 

𝑇𝑇𝑅𝑅𝑅𝑅 + 𝑇𝑇𝑇𝑇𝑇𝑇 = 𝑇𝑇𝑅𝑅𝑅𝑅𝑅𝑅𝑅𝑅𝑅𝑅 − 𝑇𝑇𝑟𝑟𝑟𝑟 − 2𝑇𝑇𝑡𝑡𝑡𝑡𝑡𝑡 = 𝑡𝑡4 − 𝑡𝑡2−𝑇𝑇𝑟𝑟𝑟𝑟 − 2𝑇𝑇𝑡𝑡𝑡𝑡𝑡𝑡 

ここで、𝑡𝑡2と𝑡𝑡4は、CMP200 で測定されたパケットの RMARKERのタイムスタンプであり、𝑇𝑇𝑟𝑟𝑟𝑟は DUTから報
告された応答時間です。ToF校正の場合、𝑇𝑇𝑡𝑡𝑡𝑡𝑡𝑡は既知の ToFです（既知の ToF値を求める方法の詳細は、以

下の図 3‑52 と図 3‑53 に示されています）。式 3‑2 の結果が実際の校正結果です。𝑇𝑇𝑅𝑅𝑅𝑅＋𝑇𝑇𝑇𝑇𝑇𝑇の半分がアンテ
ナ遅延であり、校正ルーチンの終了時にトリム値として DUTに設定されます。その結果、この更新された
トリム値が ToF検証ルーチンで採用されます（3.4.3 を参照）。 

このアプリケーションノートで説明する OTA テストソリューションの場合、𝑇𝑇𝑡𝑡𝑡𝑡𝑡𝑡は 2 つの部分に分かれてい
ます。すなわち、システムのコンポーネントで発生する固定群遅延（GD）と、無線信号の伝搬時間です。
ToF キット、UWBアンテナキット、および RFフィードスルーまたは RFスイッチのどちらかを使用した場
合、スプリッターの中央から Vivaldi アンテナの開口部までの固定 GDの合計値は、RFフィードスルーを使
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用するセットアップ（システムバリアント 1）で 4.08 ns、RFスイッチを使用するセットアップ（システム
バリアント 2）で 4.51 nsです。信号経路内の各コンポーネントの GDへの寄与の詳細を表 3‑5 に示します。 

項目 群遅延（ns） 説明 コメント 

 Ttof_fix_feedthrough Ttof_fix_Switch   

Tgs 0.12 0.12 スプリッター（中央から SUM ポー
トまで） 

ToFキットオプション CM-Z300Aに含まれ
る 

Tga 0.10 0.10 アッテネータ X ToFキットオプション CM-Z300Aに含まれ
る 

Tcable1 0.78 0.78 15 cm RFケーブル ToFキットオプション CM-Z300Aに含まれ
る 

Tswitch 該当なし 0.48 RFスイッチ SP6T アンテナキットオプション CMQ-B744Aに
含まれる 

Tfeedthr 0.05 該当なし RFフィードスルー CMQ200/CMQ500の標準構成に含まれる 

Tcable2 2.55 2.55 55 cm RFケーブル アンテナキットオプション CMQ-B725Aに
含まれる 

Tantenna 0.48 0.48 RFフィードから Vivaldiアンテナの
開口部まで  

アンテナキットオプション CMQ-B725Aに
含まれる 

SUM 4.08 4.51   

表 3‑5：信号経路に 6 dB アッテネータがある場合の固定群遅延のリスト 

図 3‑52 と図 3‑53 に、システムバリアント 1 と 2 の ToF計算の例を示します。どちらの場合も、DUTのアン

テナ（基準点）は Vivaldi アンテナから 0.15 mの位置にあるので、信号の自由空間伝搬時間𝑇𝑇𝑎𝑎𝑎𝑎𝑎𝑎＝ 𝐷𝐷
𝑐𝑐∗ʋ

＝0.50 𝑛𝑛𝑛𝑛となります。ここで、𝐷𝐷は、Vivaldi アンテナの開口部と DUTの基準点の間の距離（m）です。定数
𝑐𝑐は光速（m/ns）すなわち 0.3 m/nsです。空気中の速度係数 ʋは 1 です。固定 GD の 4.08 nsおよび 4.51 ns

を加算すると、ToFの合計値は、RFフィードスルーを使用するシステムバリアント 1 で 4.58 ns、RFスイッ
チを使用するシステムバリアント 2 で 5.01 nsとなります。 

                                                 

 

X ToFキット内の各アッテネータ（6、10、20、30 dB）の間の群遅延のバラツキは、最大で約 15 psです。この群遅延は、アッテネータを接続し
た場合のみ考慮する必要があります。 
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図 3‑52：RFフィードスルー（システムバリアント 1）で OTA距離が 0.15 mの場合の ToF計算の例 

 

図 3‑53：RFスイッチ（システムバリアント 2）で OTA距離が 0.15 mの場合の ToF計算の例  

コンポーネントの固定 GD（𝑇𝑇𝑡𝑡𝑡𝑡𝑡𝑡_𝑓𝑓𝑓𝑓𝑓𝑓_𝑓𝑓𝑓𝑓𝑓𝑓𝑓𝑓𝑓𝑓ℎ𝑟𝑟𝑟𝑟𝑟𝑟𝑟𝑟ℎまたは𝑇𝑇𝑡𝑡𝑡𝑡𝑡𝑡_𝑓𝑓𝑓𝑓𝑓𝑓_𝑠𝑠𝑠𝑠𝑠𝑠𝑠𝑠𝑠𝑠ℎ）と𝑇𝑇𝑎𝑎𝑎𝑎𝑎𝑎は、ToF校正ルーチンで設定する
必要があります。 

テストルーチン設定の要件に応じて、固定 GD 𝑇𝑇𝑡𝑡𝑡𝑡𝑡𝑡_𝑓𝑓𝑓𝑓𝑓𝑓_𝑓𝑓𝑓𝑓𝑓𝑓𝑓𝑓𝑓𝑓ℎ𝑟𝑟𝑟𝑟𝑟𝑟𝑟𝑟ℎ＝4.08 𝑛𝑛𝑛𝑛または𝑇𝑇𝑡𝑡𝑡𝑡𝑡𝑡_𝑓𝑓𝑓𝑓𝑓𝑓_𝑠𝑠𝑠𝑠𝑠𝑠𝑠𝑠𝑠𝑠ℎ＝4.51 𝑛𝑛𝑛𝑛は、
式 3‑3 を適用することで距離に変換する必要があります。 

式 3‑3 

経路遅延（𝑚𝑚）＝𝑇𝑇𝑡𝑡𝑡𝑡𝑡𝑡_𝑓𝑓𝑓𝑓𝑓𝑓 ∗ 𝑐𝑐 ∗ ʋ 
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ここで、ʋ = 0.71は計算に使用する速度係数で、光速𝑐𝑐 = 0.3 𝑚𝑚/𝑛𝑛𝑛𝑛です。 

これより、𝑇𝑇𝑡𝑡𝑡𝑡𝑡𝑡_𝑓𝑓𝑓𝑓𝑓𝑓_𝑓𝑓𝑓𝑓𝑓𝑓𝑓𝑓𝑓𝑓ℎ𝑟𝑟𝑟𝑟𝑟𝑟𝑟𝑟ℎと𝑇𝑇𝑡𝑡𝑡𝑡𝑡𝑡_𝑓𝑓𝑓𝑓𝑓𝑓_𝑠𝑠𝑠𝑠𝑠𝑠𝑠𝑠𝑠𝑠ℎは、距離にするとそれぞれ 0.87 mと 0.96 mに相当します。 

図 3‑54 に、ToF校正ルーチンの作成と設定の手順を示します。 

 

図 3‑54：テストプランエディターでの ToF校正ルーチンの作成と設定 

1. テストプランエディターの規格選択フィールドで、"Calibration" を選択します。 

2. "Add" を押して校正ルーチンを追加します。 

3. アンテナ遅延偏差の値を定義します（例：デフォルト値の 0.5 ppm） 

4. 校正モードとして "ToF" を選択します。 

5. UWBチャネルを選択します（例：チャネル 5）。 

14  

 15 

 

1 
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 7 
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 9 
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6. 固定群遅延として、0.96 m（𝑇𝑇𝑡𝑡𝑡𝑡𝑡𝑡_𝑓𝑓𝑓𝑓𝑓𝑓_𝑠𝑠𝑠𝑠𝑠𝑠𝑠𝑠𝑠𝑠ℎ、システムバリアント 2 の場合）または 0.87 m

（𝑇𝑇𝑡𝑡𝑡𝑡𝑡𝑡_𝑓𝑓𝑓𝑓𝑓𝑓_𝑓𝑓𝑓𝑓𝑓𝑓𝑓𝑓𝑓𝑓ℎ𝑟𝑟𝑟𝑟𝑟𝑟𝑟𝑟ℎ、システムバリアント 1 の場合）を入力します。 

7. Vivaldi アンテナと DUTアンテナの間の自由空間距離を入力します（例：0.15 m）。 

8. 適切な DUT Rx パワーおよび Txパワーレベルを入力します。これらのパワーレベルの求め方について
は、78 ページの付録 Dを参照してください（注意：パワーレベルが不適切な場合、CMP200 での信号検
出が安定しない可能性があります）。 

9. これは校正ルーチンなので、"ToF Verification" を "False" に設定します。 

10. "Trim Clean ToF Ant Delay" フラグを "True" に設定して、DUTのアンテナ遅延のトリム値をこのルーチ
ンの開始時にクリーンにすることを指定します。 

11. 信号は空気中を伝搬するので、速度係数を "1" に設定します。 

12. 波形ファイル名はデフォルトのままにしておきます。 

テスト開始前に、2 つの波形ファイルを CMP200 にアップロードする必要があります（波形ファイルの
処理については、81 ページの付録 Eを参照してください）。2 つの波形ファイルは、DUT（NCJ29D5）
の要件に従って、CMP200 上で 8 msのタイムインターバル（図 3‑55）で再生されます。 

─ 波形ファイル 1（プレポーリングパケット）： 

FC1T2_Data_Phr_LinPhaseRRC0p45_waveform_1_resample.wv 

─ 波形ファイル 2（ポーリングパケット）： 

FC1T1ND_Ranging_LinPhaseRRC0p45_waveform_2_resample.wv 

 

図 3‑55：NXP NCJ29D5 の測距メッセージフロー 

13. ToF校正ルーチン名を指定します（例："ToF Cal CH5"）。 

14. ToF校正に使用する Tx方向と Rx方向の両方のコネクタのコネクタ名を指定します（例："ToF_TX"、
"ToF_RX"）。指定したコネクタ名は、testconfig.iniファイルに記述されているものと一致する必要
があります（FDCとコネクタの対応については 3.3.1 を参照）。 

15. メインメニューバーで、"File" > "Save/Save As"…を選択して、テストプランを保存します。 
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ToF校正ルーチンをテストランナーで実行すると（3.2.2 を参照）、DUTのアンテナ遅延（ns）が判定され、
対応するトリム値がトリムパラメータ ANTENNA_DELAYによって DUT に設定されます。図 3‑56 に示す例で
は、アンテナ遅延は 4.13 nsで、15.65 psの分解能精細度により、トリム値 263 に変換されます。 

 

図 3‑56：テストランナーでの ToF校正結果 

3.4 検証 

この章では、WMTでのトランスミッター、レシーバー、ToFの検証ルーチンとその結果について説明しま
す 。 

車載用 NXP®チップ（NXP Trimension™ NCJ29D5）に対する CMP200 での UWBテスト用の推奨製品一覧を表
3‑6 に示します。 

カテゴ
リ 

測定製品（章） 必要な R&S機器／オプション 

Tx/パ
ワー 

プリアンブルパワー（3.4.1.1） CMP200、KM300 UWB 

Tx/パ
ワー 

データパワー（3.4.1.2） CMP200、KM300 UWB 

Tx/変
調 

周波数エラー（3.4.1.3） CMP200、KM300 UWB 

Tx/変
調 

チップクロックエラー（3.4.1.4） CMP200、KM300 UWB 

Tx/パ
ルスマ
スクマ
ージン 

パルスマスク（3.4.1.5） CMP200、KM300 UWB 

Tx/変
調 

SHR/PHR/PSDU/STS NRMSE

（3.4.1.6） 

CMP200、KM300 UWB 

Tx/パ
ルスレ
ベル 

平均 PHR/PSDU/STSパルスレベル、
SHR基準（3.4.1.7） 

CMP200、KM300 UWB 

Tx/マ
スク 

スペクトラムマスクの送信（3.4.1.8） CMP200、KM300 UWB 

Tx/パ
ワー 

最大スペクトラムパワー[dBm/MHz]

（3.4.1.9） 

CMP200、KM300 UWB 
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カテゴ
リ 

測定製品（章） 必要な R&S機器／オプション 

Tx/パ
ワー 

最大ピークスペクトラムパワー
[dBm/50 MHz]（3.4.1.10） 

CMP200、KM300 UWB 

受信 RX感度（3.4.2） CMP200、任意波形発生器 UWB SW オプション 

ToF 測距 DS-TWR/SS-TWR（3.4.3） CMP200、任意波形発生器＋KM300＋ToFキット 

表 3‑6：CMP200 での NXP Trimension™ NCJ29D5 の測定に使用する製品 

3.4.1 トランスミッター 

トランスミッターテストでは、パワー、パルスレベル、パルスマスク、送信スペクトラムマスク測定を行い
ます。 

すべてのトランスミッターテストで SP3 が考慮されます。このため、UWBフレームのデータ部分
（PHR/PSDU）に対する測定はすべて利用できません。これらが必要な場合は、SP0 を構成する必要があり
ます。 

トランスミッター検証ルーチンを作成して設定するには、図 3‑57 の手順を実行します。 
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図 3‑57：テストプランエディターでの Tx検証ルーチンの作成と設定 

1. テストプランエディターの規格選択フィールドで、"UWB" を選択します。 

2. "Add" を押して検証ルーチンを追加します。 

3. 方向として "Tx" を選択します。 

4. UWBチャネルを選択します（例：チャネル 5）。 

5. リストから Tx測定を選択します（図 3‑58 を参照）（例：パワー、変調、マスク）。 
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図 3‑58：Tx測定項目 

6. "Power TX" を "0" に設定します。 

7. STSパケット構造を "3" に設定します。 

8. 検証ルーチン名を指定します（例："Tx Verification CH5"）。 

9. Tx方向と Rx方向の両方のコネクタのコネクタ名を指定します（例："ANT1_TX"、"ANT1_RX"）。指定
したコネクタ名は、testconfig.iniファイルに記述されているものと一致する必要があります（FDC

とコネクタの対応については 3.3.1 を参照）。 

10. メインメニューバーで、"File" > "Save/Save As"…を選択して、テストプランを保存します。 
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図 3‑59：WMTテストランナーでの SP3による Tx検証結果 

図 3‑59 に、Tx検証ルーチン実行後（3.2.2 を参照）にテストランナーに表示されたトランスミッターテスト
結果を示します。 

以後の各章では、各トランスミッターテストと適用される合格基準について説明します。 

3.4.1.1 プリアンブルパワー 

プリアンブルパワーは、UWB PPDU のプリアンブル部分の平均パワーです。 
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3.4.1.2 データパワー 

データパワーは、UWB PPDUの物理層ペイロードの平均パワーです。 

3.4.1.3 周波数エラー 

[4]の第 15.4.9 章によれば、HRP UWBの物理層送信中心周波数許容値は±20×10－6です。3.4.1.4 で説明する
チッピングクロックの許容値は、これに優先します。 

3.4.1.4 チップクロックエラー 

[4]の第 15.4.6 章によれば、HRP UWBトランスミッターは 499.2 MHzのピーク PRFでのチッピング機能を持
つ必要があり、要求される精度は±20×10－6です。さらに、HRP UWBの各物理層チャネルに関して、送信
エネルギーの中心は、表 1‑1 に記載されている値に、やはり±20×10－6の精度で一致する必要があります。
測定には、1 MHzの分解能帯域幅と 1 kHzのビデオ帯域幅が用いられます。 

3.4.1.5 パルスマスク 

[5]の第 15.4.4 章によれば、プリカーサー付きのパルスを使用する UWBデバイスの場合、送信パルスが、ロ
ールオフ係数β = 0.45 の基準ルートナイキストパルス r(t)の式（式 1‑1）に、最低±3 チップ周期にわたって
従うことが推奨されます。送信パルスが最小プリカーサーパルス推奨事項に従う場合、送信パルス形状 p(t)

は、図 3‑60 のタイムドメインマスクによって制約される必要があります。ここで、パルスのピークは t＝0 

nsで振幅 1 に正規化され、値 1 にスケーリングされます。時間単位は表 3‑7 で定義される Tpです。 

チャネル番号 パルスの持続時間 Tp（ns） メインローブ幅 Tw（ns） 

{0:3, 5:6, 8:10, 12:14} 2.00 0.5 

7 0.92 0.2 

{4, 11} 0.75 0.2 

15 0.74 0.2 

表 3‑7：各 UWB チャネルの基準パルス持続時間（ [4]の表 15-12） 

パルスは最初のピーク振幅まで単調に増加する必要があります。最初のピーク振幅は、パルスが最初に
1.25 %より大きく減少する前の最大振幅と定義されます。 
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図 3‑60：Tpが 2 nsの HRP UWB 物理層パルスのタイムドメインマスク  

名称 タイムインターバル×Tp （X

軸） 

リミット値（Y軸） 

領域 1（下） [-3, 0]  -0.015 

領域 2（下） [0, 2] -0.5 

領域 3（下） [2, 3] -0.3 

領域 1（上） [-3, -1.25] 0.015 

領域 2（上） [-1.25, 1] 1.0 

領域 3（上） [1, 3] 0.3 

表 3‑8：パルス振幅マスクのリミットライン定義 

図 3‑59 では、結果が次に示すマージン値で示されています。 

マージン＝リミット値－測定値 

すなわち、マージン値が 0 より大きい場合、測定値はマスクの範囲内です。そうでなければ、測定値は定義
されたリミットを超えています。 

3.4.1.6 SHR/PHR/PSDU/STS NRMSE 

SHR/PHR/PSDU/STSに対する正規化実効値（NRMSE）測定は、Fira 仕様の「Transmit Signal Quality（送信
信号品質）」の章に基づいています。 

SHRおよび STSの場合：NRMSE＜25 % 

PHRおよび PSDU の場合：NRMSE＜30 % 

3.4.1.7 平均 PHR/PSDU/STSパルスレベル、SHR基準 

平均 PHR/PSDU/STSパルスレベル（SHR基準）は、Fira 仕様の「Transmit Signal Quality（送信信号品質）」
の章に基づいています。これは±2 dB 以内である必要があります。 



 

Rohde & Schwarz | Application Note Automotive UWB Device Testing Over the Air  62 

 

  

3.4.1.8 スペクトラムマスクの送信 

[4]の第 15.4.5 章によると、送信スペクトラムは、信号の最大スペクトラム密度を基準として、0.65/Tp＜|f－
fc|＜0.8/Tpでは－10 dB、|f－fc|＞0.8/Tpでは－18 dBより小さい必要があります。ここで、fcはチャネルの中
心周波数、Tpは関連するチャネルのパルスの持続時間です。測定には、1 MHzの分解能帯域幅と 1 kHzのビ
デオ帯域幅が用いられます。 

表 3‑9 に、さまざまなパルスの持続時間に対する送信 PSDマスクのリミットラインの概要を示します。 

チャネル番号 パルスの持続時間 Tp（ns）  |f – fc|  

  －10 dB －18 dB 

{0:3, 5:6, 8:10, 12:14} 2.00 325 MHz 400 MHz 

7 0.92 705 MHz 870 MHz 

{4, 11} 0.75 867 MHz  1067 MHz 

15 0.74 878 MHz 1081 MHz 

表 3‑9：送信スペクトラムマスクのリミットライン 

例えば、チャネル 9 は 7.987 GHz（fc）で動作し、パルスの持続時間は 2 ns です。したがって、チャネル 9

の送信スペクトラムマスクは図 3‑61 に示すようになります。 

 

図 3‑61：チャネル 9 の送信スペクトラムマスク 

名称 周波数レンジ （X軸） リミット値（Y軸） 

領域 1 [0.65/Tp, 0.8/Tp]  －10 dB 

領域 2 ＞0.8/Tp －18 dB 

表 3‑10：送信スペクトラムマスクのリミットライン定義 

結果の評価はマージンに基づきます。ここで、 

マージン＝リミット値－測定値 

すなわち、マージン値が 0 より大きい場合、測定値はマスクの範囲内です。そうでなければ、測定値は定義
されたリミットを超えています。 
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3.4.1.9 最大スペクトラムパワー[dBm/MHz] 

1 MHzの分解能帯域幅（RBW）で測定された最大平均スペクトラムパワー。パワーは PPDU全体にわたっ
て、または PPDUから 1 msにわたって測定されます [15]。FCC要件によれば、最大スペクトラムパワー密
度は－41.3 dBm/MHzより小さい必要があります。 

3.4.1.10 最大ピークスペクトラムパワー[dBm/50 MHz] 

50 MHzの分解能帯域幅（RBW）で測定された最大ピークスペクトラムパワー [15]。FCCセクション 15 によ
れば、これは 0 dBm/50 MHzより小さい必要があります。 

3.4.2 レシーバー感度 

レシーバー感度は、DUT が 1 %以下のパケットエラーレート（PER）を達成できる最低の受信信号パワーレ
ベルです。これは Fira 仕様の「パケット受信感度」の章に基づいています。 

レシーバー感度テストルーチンを作成して設定するには、図 3‑62 の手順を実行します。 
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図 3‑62：テストプランエディターでの Rx検証ルーチンの作成と設定 

1. テストプランエディターの規格選択フィールドで、"UWB" を選択します。 

2. "Add" を押して検証ルーチンを追加します。 

3. 方向として "Rx" を選択します。 

4. UWBチャネルを選択します（例：チャネル 5）。 

5. リストから "Sens" Rx測定を選択します（図 3‑58 を参照）。 
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図 3‑63：Rx測定項目から "Sens" を選択 

6. UWB規格を選択します。 

7. 受信パケット数を指定します。 

8. 初期レシーバーパワーレベル範囲（最大値、最小値）と感度探索を終了するデルタ値を定義します。デ
フォルト設定のレシーバーパワー最大値－80 dBm、最小値－110 dBm、デルタ 1 dBをそのまま使用で
きます。レシーバー感度探索の詳細については、82 ページの付録 Fを参照してください。 

9. レシーバー感度リミットを指定します。デフォルト設定の 1 %を使用できます。 

10. "Waveform" フィールドにはデフォルト値の "None" を使用します。波形ファイルは WinIQSIM によって
オンザフライで作成されます。 

11. 検証ルーチン名を指定します（例："Rx Verification CH5"）。 

12. Tx方向と Rx方向の両方のコネクタのコネクタ名を指定します（例："ANT1_TX"、"ANT1_RX"）。指定
したコネクタ名は、testconfig.iniファイルに記述されているものと一致する必要があります（FDC

とコネクタの対応については 3.3.1 を参照）。 

13. メインメニューバーで、"File" > "Save/Save As"…を選択して、テストプランを保存します。 

 

図 3‑64：テストランナーでの Rx検証結果 

テストランナーでの Rx 検証ルーチンの実行後（3.2.2 を参照）、図 3‑64 の結果から、レシーバーパワーレベ
ルが－90.31 dBmのときに PERが 0 %（1 %のリミットより下）を達成していることがわかります。この DUT

のレシーバー感度は、－90.31 dBmです。 

3.4.3 ToF測距（SS-TWR） 

ここでは、図 3‑51 に示す ToF校正と同じ原理が考慮されます。 ただし、ToF測距検証ルーチンでは、ToF

校正ルーチンの実行（3.3.2.3 を参照）によって得られた DUT内部アンテナ遅延𝐷𝐷𝑇𝑇𝑅𝑅𝑅𝑅＋𝑇𝑇𝑇𝑇𝑇𝑇の値に基づいて、
測距距離、あるいはそれと等価な Vivaldi アンテナと DUTの間の ToFを検証します。 
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ToF検証ルーチンを作成して設定するには、図 3‑65の手順を実行します。 

  

図 3‑65：テストプランエディターでの ToF検証ルーチンの作成と設定 

1.  テストプランエディターの規格選択フィールドで、"Calibration" を選択します。 

2. "Add" を押して校正ルーチンを追加します。 

3. 校正モードとして "ToF" を選択します。 

4. UWBチャネルを選択します（例：チャネル 5）。 

5. 固定群遅延として、0.96 m（𝑇𝑇𝑡𝑡𝑡𝑡𝑡𝑡_𝑓𝑓𝑓𝑓𝑓𝑓_𝑠𝑠𝑠𝑠𝑠𝑠𝑠𝑠𝑠𝑠ℎ、システムバリアント 2 の場合）または 0.87 m

（𝑇𝑇𝑡𝑡𝑡𝑡𝑡𝑡_𝑓𝑓𝑓𝑓𝑓𝑓_𝑓𝑓𝑓𝑓𝑓𝑓𝑓𝑓𝑓𝑓ℎ𝑟𝑟𝑟𝑟𝑟𝑟𝑟𝑟ℎ、システムバリアント 1 の場合）を入力します（3.3.2.3 を参照）。 

6. 検証目的の経路遅延として "0" を入力します。 
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7. 適切な DUT Rx パワーおよび Txパワーレベルを入力します。これらのパワーレベルの求め方について
は、78 ページの付録 Dを参照してください（注意：パワーレベルが不適切な場合、CMP200 での信号検
出が安定しない可能性があります）。 

8. これは検証ルーチンなので、"ToF Verification" を "True" に設定します。 

9. "Trim Clean ToF Ant Delay" フラグを "False" に設定して、DUTのアンテナ遅延のトリム値を保持するこ
とを指定します。 

10. 信号は空気中を伝搬するので、速度係数を "1" に設定します。 

11. 波形ファイル名はデフォルトのままにしておきます。 

テスト開始前に、2 つの波形ファイルを CMP200 にアップロードする必要があります（波形ファイルの
処理については、81 ページの付録 Eを参照してください）。 

─ 波形ファイル 1（プレポーリングパケット）： 

FC1T2_Data_Phr_LinPhaseRRC0p45_waveform_1_resample.wv 

─ 波形ファイル 2（ポーリングパケット）： 

FC1T1ND_Ranging_LinPhaseRRC0p45_waveform_2_resample.wv 

12. ToF校正ルーチン名を指定します（例："ToF Ver CH5"）。 

13. ToF校正に使用する Tx方向と Rx方向の両方のコネクタのコネクタ名を指定します（例："ToF_TX"、
"ToF_RX"）。指定したコネクタ名は、testconfig.iniファイルに記述されているものと一致する必要
があります（FDCとコネクタの対応については 3.3.1 を参照）。 

14. メインメニューバーで、"File" > "Save/Save As"…を選択して、テストプランを保存します。 

 

図 3‑66：テストランナーでの ToF検証結果 

テストランナーでの ToF検証ルーチンの実行後（3.2.2 を参照）、検証結果から、Vivaldi アンテナと DUTア
ンテナの間の距離測定値（cm）と、対応する空気中での ToFがわかります。図 3‑66 に示す結果の例では、
測距結果は 15.08 cmで、きわめて正確です（Vivaldi アンテナと DUTアンテナの間の物理的距離は 15 

cm）。 

 
 

ToF 

距離 
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図 3‑67：ToFセッションの PPDUの測定 

WMTに加えて、CMsquares の CMP200 パワー対時間（PvT）スクエアには、CMP200 によって検出された各
PPDUの測定結果を含む ToFセッションの概要が示されます。図 3‑67 に示すように、ToF セッション全体で
合計 3 つの PPDUが検出されています。UWB 測定設定で PPDU 番号を選択すると、選択した PPDUの測定の
詳細が表示されます。 
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5 付録 

A Mini-Circuitsパワースプリッター／コンバイナーZFRSC-183+データシート 

 

表 5‑1：Mini-Circuitsパワースプリッター／コンバイナーZFRSC-183+の性能データ（出典：Mini-Circuits）  

B WMTテストプランエディターでのパラメータ 

B.1 共通設定 

 

図 5‑1：共通設定 

 

パラメータ 説明 設定 

Name テストルーチン名 任意 
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パラメータ 説明 設定 

Connector TX DUT 送信経路（DUT から CMP200へ）のコネクタ識別子 この名前は、testconfig.iniファイルの対応するセク
ション名と一致する必要があります（3.3.1 を参照）。 

Connector RX DUT 受信経路（CMP200 から DUTへ）のコネクタ識別子 この名前は、testconfig.iniファイルの対応するセク
ション名と一致する必要があります（3.3.1 を参照）。 

Direction DUT から見た方向を指定します。 TXまたは RX（またはその両方） 

Breakpoint Mode ブレークポイントモードをオンにします。これにより、
テストルーチンがブレークポイント機能をサポートして
いれば、テストルーチンを停止して、CMsquaresで測定
を手動で開始し、チェックできるようになります。これ
は主にデバッグのために必要です。 

Always（常に）/On Failure（障害発生時） 

Breakpoint TX Txテストルーチンのブレークポイントをオン／オフしま
す。 

True/False 

Breakpoint RX Rxテストルーチンのブレークポイントをオン／オフしま
す。 

True/False 

表 5‑2：テストプランエディターでのテストプランの共通設定 

B.2 トランスミッターテストの設定 

 

図 5‑2：STSパケット構造 3（SP3）でのトランスミッターテストの設定 

パラメータ 説明 設定 

Additional Tasks 自動レベル調整（オートレンジ） オン／オフ 

Bandwidth UWB チャネル帯域幅 表 1‑1 を参照 

Channel UWB チャネル 表 1‑1 を参照 

Data Rate PSDUビットレート（1.3.4 を参照） STSパケット構造
3 を選択した場合、このフィールドは非表示です。 

表 1‑5、表 1‑6および表 1‑7を参照 

Frequency チャネルの中心周波数 表 1‑1 を参照 
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パラメータ 説明 設定 

Measurement Tx トランスミッターテスト項目 パワー／変調／相関／チップジッター／シンボルジッ
ター／マスク/PvT/信号情報 

Mode UWB 規格 802.15.4/802.15.4z 

Packets Tx 送信パケット数 0…5000 

Payload Tx トランスミッターテスト用のペイロード。SP0 の場合
のみ必要 

SP0：必須（例：0x01、0x02、0x03） 

SP3：なし  

PHR Data Rate PHRデータレートモード（1.3.4を参照）。 802.15.4：DRMDR 

802.15.4z：DRBM_LP/DRBM_HP/DRHM_LR/DRHM_HR 

PHR Rate PHRビットレート（1.3.4を参照） STSパケット構造 3

を選択した場合、このフィールドは非表示です。 

表 1‑5、表 1‑6および表 1‑7を参照 

Power Tx 公称 Txパワー設定 －12 dBm～＋14 dBm（分解能 0.25 dBm） 

Preamble Code Index プリアンブルコードインデックスを設定します。 1.3.3.1を参照 

Preamble Length プリアンブルシンボルの繰り返し回数（1.3.3.1を参
照） 

16 / 32 /64 / 1024 / 4096  

PRF Mode PRFモードを指定します。 BPRF / HPRF 

SFD Type SFDタイプを指定します（1.3.3.2を参照）。 0/1/2/3/4（表 1‑4 を参照） 

Statistic Tx 測定の繰り返し回数  ＞0 

STS Index 現在の STSインデックスを指定します（1.3.5を参
照）。STSパケット構造 0 を選択した場合、このフィ
ールドは非表示です。 

表 1‑8 を参照 

STS Length STS長を指定します（1.3.5 を参照）。STSパケット構
造 0 を選択した場合、このフィールドは非表示です。 

表 1‑8 を参照 

STS Packet 

Structure 
802.15.4z で定義された STSパケット構造（1.3.5 を参
照） 

0 / 1 / 2 / 3XI 

STS Segment Count STSセグメント数を指定します（1.3.5を参照）。STS

パケット構造 0を選択した場合、このフィールドは非
表示です。 

表 1‑8 を参照 

表 5‑3：テストプランエディターでの Txテストの設定 

                                                 

 

XI NXP NCJ29D5 UCI仕様 1.16（2021年 7月 7 日）では、SP0と SP3のみがサポートされます。 
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B.3 レシーバーテストの設定 

 

図 5‑3：STSパケット構造 0（SP0）でのレシーバーテストの設定 

パラメータ 説明 設定 

Bandwidth UWB チャネル帯域幅 表 1‑1 を参照 

Channel UWB チャネル 表 1‑1 を参照 

Data Rate PSDUビットレート（1.3.4 を参照） STSパケット構造
3 を選択した場合、このフィールドは非表示です。 

表 1‑5、表 1‑6および表 1‑7を参照 

Frequency チャネルの中心周波数 表 1‑1 を参照 

Measurement Rx レシーバーテストのタイプを選択します。 RxLevel/PER/PER Sweep/Sens 

Mode UWB 規格 802.15.4/802.15.4z 

Packets Rx 受信パケット数 0…5000  

Packets Rx Gap DUT に送信される 2つの連続するパケットの間のアイ
ドル時間 

0～100 ms 

Payload レシーバーテスト用のペイロード。ペイロードソース
が "List" に設定されている場合のみ、ここでペイロー
ドを指定する必要があります。STSパケット構造 3 を
選択した場合、このフィールドは非表示です。 

0x618801CADE9A555352434E35EC65270AB591 

Payload Length ペイロード長。ペイロードソースが "List" に設定され
ている場合は設定する必要はありません。STSパケッ
ト構造 3を選択した場合、このフィールドは非表示で
す。 

0..127 

Payload MAC FCS MACフレームチェックシーケンス（FCS）フィールド
を有効／無効にします。このパラメータ設定は、ペイ
ロードソースが "List" に設定されている場合のみ必要

True/False 
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パラメータ 説明 設定 

です。STSパケット構造 3 を選択した場合、このフィ
ールドは非表示です。 

Payload Source 

  
データソースを選択します。 

List：バイナリーファイル  

PRBS9：ワード長 9ビットの疑似ランダムバイナリシ
ーケンス（PRBS） 

All0：すべて 0 のデータを含む内部生成シーケンス 

All1：すべて 1 のデータを含む内部生成シーケンス 

STSパケット構造 3 を選択した場合、このフィールド
は非表示です。 

List/PRBS9/All0/All1 

PHR Data Rate PHRデータレートモード（1.3.4を参照）。 802.15.4：DRMDR 

802.15.4z：DRBM_LP/DRBM_HP/DRHM_LR/DRHM_HR 

PHR Rate PHRビットレート（1.3.4を参照） STSパケット構造 3

を選択した場合、このフィールドは非表示です。 

表 1‑5、表 1‑6および表 1‑7を参照 

Power Rx Delta 最大受信パワーレベルと最小受信パワーのパワー差を
指定します（付録 Fを参照）。 

例：1 dB 

Power Rx Max 初期最大受信パワーレベルを指定します（付録 Fを参
照）。 

例：－80 dBm 

Power Rx Min 初期最小受信パワーレベルを指定します（付録 Fを参
照）。 

例：－110 dBm 

Preamble Code Index プリアンブルコードインデックスを設定します。 1.3.3.1を参照 

Preamble Length プリアンブルシンボルの繰り返し回数（1.3.3.1を参
照） 

16 / 32 /64 / 1024 / 4096  

PRF Mode PRFモードを指定します。 BPRF / HPRF 

Sens Limit レシーバー感度リミットを指定します。 例：1% 

SFD Type SFDタイプを指定します（1.3.3.2を参照）。 0/1/2/3/4（表 1‑4 を参照） 

STS Index 現在の STSインデックスを指定します（1.3.5を参
照）。STSパケット構造 0 を選択した場合、このフィ
ールドは非表示です。 

表 1‑8 を参照 

STS Length STS長を指定します（1.3.5 を参照）。STSパケット構
造 0 を選択した場合、このフィールドは非表示です。 

表 1‑8 を参照 

STS Packet 

Structure 
802.15.4z で定義された STSパケット構造（1.3.5 を参
照） 

0/1/2/3（Error! Bookmark not defined.ページの脚注 XI

を参照） 

STS Segment Count STSセグメント数を指定します（1.3.5を参照）。STS

パケット構造 0を選択した場合、このフィールドは非
表示です。 

表 1‑8 を参照 

Waveform CMP200での再生に使用する波形ファイル名を指定し
ます。"None" というテキストを指定した場合、波形フ
ァイルは、上記の設定フィールドに指定されたパラメ
ータ設定を使用して、オンザフライで作成されます。 

"None" または CMP200 にアップロードされている波
形ファイル名を入力します。波形ファイルの取り扱い
の詳細については、付録 Eを参照してください。 

表 5‑4：テストプランエディターでの Rxテストの設定 
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B.4 ToFの設定 

 

図 5‑4：STSパケット構造 3（SP3）での ToFテストの設定 

パラメータ 説明 設定 

Additional Tasks レベル調整 オン／オフ 

Ant Delay Deviation アンテナ遅延の偏差を指定します。 例：0.5 ppm 

Cal Mode 校正モードを選択します。 ToF 

Channel UWB チャネル 表 1‑1 を参照 

First Package Delay NXPチップの固定値（NXP NCJ29D5） 8 

Frequency チャネルの中心周波数 表 1‑1 を参照 

   

Path Delay スプリッターから Vivaldiアンテナ開口
部までの固定経路遅延 

システムバリアント 1（RFフィードスルーを使用）の場合は 0.87XII 

システムバリアント 2（RFスイッチを使用）の場合は 0.96 

Path Delay On Air 自由空間距離（m）  ToF校正ルーチン：Vivaldiアンテナと DUT アンテナの間の自由空間
距離（m）を入力します。 

ToF検証ルーチン：0 

Power Rx DUT 受信パワーレベル 付録 Dを参照 

Power Tx DUT 送信パワーレベル 付録 Dを参照 

Second Package Delay NXPチップの固定値（NXP NCJ29D5） 16 

Statistic Count 測定の繰り返し回数 ＞1 

STS Length STS長を指定します（1.3.5 を参照）。 表 1‑8 を参照 

STS Packet Structure 802.15.4z で定義された STS部分を含む
パケット構造（1.3.5 を参照） 

1/2/3（Error! Bookmark not defined.ページの脚注 XIを参照） 

                                                 

 

XII 計算された値には、6 dBアッテネータの群遅延が含まれます。計算の詳細については、第 3.3.2.3章を参照してください。 
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パラメータ 説明 設定 

ToF Verification ToF検証ルーチンかどうかを示しま
す。 

True/False 

Trim Clean TOF Ant 

Delay 
デバイスの ToFアンテナ遅延トリム値
をリセット 

True/False 

Velocity Factor 空気中の速度係数を指定します。 1  

Waveform プレポーリング用波形ファイル（NXP

固有） 

'FC1T2_Data_Phr_LinPhaseRRC0p45_waveform_1_resample.wv' 

Waveform Poll ポーリングメッセージ用波形ファイル
（NXP固有） 

'FC1T1ND_Ranging_LinPhaseRRC0p45_waveform_2_resample' 

表 5‑5：テストプランエディターでの ToFテストの設定 

C テストプラン構成ファイル（testconfig.ini） 

テストランナーでテストプランを実行するには、各テスト実行にテスト構成ファイルを割り当てる必要があ
ります。 

テスト構成は拡張子が.iniのプレーンテキストファイルであり、WMTインストールディレクトリのサブフ
ォルダー\etcに存在します。デフォルトでは、構成ファイルの名前は testconfig.iniです。ファイル名は
もちろんユーザー定義可能です。 

下の表 5‑6 に、サンプル testconfig.ini構成ファイルのエントリの一覧を示します。角括弧内のニーモニッ
クは、構成セクションの先頭を示します。 

テスト構成 コメント 

[general]  

testplan = testplans/UWB/test_UWB_TX_CH5.json 選択したテストプラン 

;testplan = testplans/UWB/test_UWB_RX_PER_65_CH5.json 先頭がセミコロンの行は選択解除されたテストプランを示しま
す。 

logs = etc/logs ログファイルの場所 

results = etc/results 結果ファイルの場所 

limitcheck = True リミットチェックを有効化 

loglevel = debug ログレベルの定義（debug/info） 

results_json = False JSONフォーマットの結果ファイル 

results_txt = True テキストフォーマットの結果ファイル 

[logging]  

level = debug レベル定義（debug/info） 

format = %(asctime)s %(levelname)s:%(name)s %(message)s ログフォーマット 

[uwb]  

connection = serial UWB 検証ルーチンで使用される DUTの接続タイプを定義しま
す。 
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テスト構成 コメント 

port = COM3 接続された DUT の仮想 COM ポートを指定します。Windowsデバ
イスマネージャーで、使用されている COMポートを確認しま
す。 

baudrate = 460800 シリアル接続のボーレートを定義します。 

driver = nxp.ncj29d5.ncj29d5_uci WMTで DUT の UCI制御に使用するドライバーを指定します。こ
れは WMT のインストールに含まれています。ドライバー自体
は、WMT のインストールディレクトリのサブフォルダー
dutdriver\にあります。 

timeout = 0.1 シリアル通信のタイムアウト値  

keep_open = True シリアルポートを開いておく 

[calibration] 
 

api = nxp.ncj29d5.calapi DUT 校正 APIを指定します。これは WMT のインストールに含ま
れています。APIは、WMTのインストールディレクトリのサブフ
ォルダーcalibration\にあります。 

connection = serial UWB 校正ルーチンで使用される DUTの接続タイプを定義しま
す。 

port = COM3 接続された DUT の仮想 COM ポートを指定します。Windowsデバ
イスマネージャーで、使用されている COMポートを確認しま
す。 

driver = nxp.ncj29d5.ncj29d5_uci WMTで DUT の UCI制御に使用するドライバーを指定します。こ
れは WMT のインストールに含まれています。ドライバー自体
は、WMT のインストールディレクトリのサブフォルダー
dutdriver\にあります。 

baudrate = 460800 シリアル接続のボーレートを定義します。 

timeout = 0.1 シリアル通信のタイムアウト値  

keep_open = True シリアルポートを開いておく 

[instrument] 
 

connection = socket CMP200のリモート制御インタフェースを定義します。ソケット
接続が使用されます。 

host = 10.202.1.50 CMP200の IPアドレスを指定します。 

port = 5025 ソケット接続のポート番号を指定します。ポート 5025 は、VISA

での Rawソケット接続用のデフォルトポートです。  

timeout = 10 リモートポートのタイムアウトタイマーを定義します。 

[arbgen] 
 

enabled = True WinIQSIM2 ソフトウェアを使用して任意波形発生器をアクティブ
にします。 

connection = socket 任意波形発生器へのソケット接続を定義します。 

host = 127.0.0.1 任意波形発生器の IPアドレスを指定します。ここでローカルホス
トの IPアドレス 127.0.0.1 を使用するのは、WinIQSIM2ソフトウェ
アが WMT と同じ PC上で実行されているからです。 

port = 5025 ソケット接続のポート番号を指定します。ポート 5025 は、VISA

での Rawソケット接続用のデフォルトポートです。 

timeout = 5 リモートポートのタイムアウトタイマーを定義します。 

[relay] 
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テスト構成 コメント 

enabled = True CMQチャンバーの RFスイッチの制御をアクティブにします。 

connection = socket CMQのリモート制御インタフェースを定義します。ソケット接続
が使用されます。 

host = 192.168.178.41 CMQの IPアドレスを指定します。これは固定 IPアドレスです。 

port = 5000 ソケット接続のポート番号を指定します。ポート 5000 は CMQチ
ャンバーの固定ポート番号です。 

timeout = 5 リモート制御のタイムアウトタイマーを定義します。 

termchar = \r リモート制御コマンドの終端文字を定義します。 

driver = wmt.equipment.cmq CMQ制御ドライバーを指定します。これは WMT のインストール
に含まれています。ドライバーは、WMTのインストールディレク
トリのサブフォルダーwmt\equipmentにあります。この例では
cmqという名前のドライバーを使用しています。 

[ANT1_TX] セクション名 ANT1_TXはユーザー定義可能です。これは接続の識
別子です。この名前は、テストプランエディターの共通設定部分
の "Connector TX" フィールドに入力された名前と一致する必要が
あります（表 5‑2を参照）。 

connector = Port1.IFIn 物理ケーブル接続に従って、CMP200の Port1.IFIn コネクタを指定
します。 

fdc = FDC_ANT1_TX この接続に関連付けられている FDCテーブル名を指定します。 

relay = 1.1.1 CMQのリレー位置を指定します（3.1.1.6 を参照）。 

[ANT1_RX] セクション名 ANT1_RXはユーザー定義可能です。これは接続の識
別子です。この名前は、テストプランエディターの共通設定部分
の "Connector RX" フィールドに入力された名前と一致する必要が
あります（表 5‑2を参照）。 

connector = Port1.IFOut 物理ケーブル接続に従って、CMP200の Port1.IFOut コネクタを指
定します。 

fdc = FDC_ANT1_RX この接続に関連付けられている FDCテーブル名を指定します。 

relay = 1.1.1 CMQのリレー位置を指定します（3.1.1.6 を参照）。 

[FDC_ANT1_RX] FDC_ANT1_RXという名前の FDC 

6500.0 = 36.3 周波数（MHz）、減衰量（dB）（表 3‑3 を参照） 

8000.0 = 38.4 周波数（MHz）、減衰量（dB）（表 3‑3 を参照） 

[FDC_ANT1_TX] FDC_ANT1_TXという名前の FDC 

6500.0 = 36.3 周波数（MHz）、減衰量（dB）（表 3‑3 を参照） 

8000.0 = 38.4 周波数（MHz）、減衰量（dB）（表 3‑3 を参照） 

表 5‑6：testconfig.iniファイルの例 

D ToFテストのパワーレベル設定 

図 3‑51 に示すように、ToF校正／検証を実行する際に、CMP200 は、𝑡𝑡2𝑡𝑡4𝑇𝑇𝑅𝑅𝑅𝑅𝑅𝑅𝑅𝑅𝑅𝑅の計算の基になる時間イン
スタンスおよびで 2 個のパケットを受信します。安定した信号検出のためには、CMP200 の IFin ポートでの
これら 2 個のパケットのパワーレベルが、次の基準を満たす必要があります。 
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1. CMP200 の IFin ポートに𝑃𝑃𝐶𝐶𝐶𝐶𝐶𝐶_𝐼𝐼𝐼𝐼𝐼𝐼𝐼𝐼_𝑃𝑃1𝑃𝑃𝐶𝐶𝐶𝐶𝑃𝑃_𝐼𝐼𝐼𝐼𝐼𝐼𝐼𝐼_𝑃𝑃2𝑡𝑡2と𝑡𝑡4に到着して検出される 2 個のパケットの絶対パワー
レベルおよびは、それぞれ－50 dBm以上である必要があります。ここで、𝑃𝑃𝐶𝐶𝐶𝐶𝐶𝐶_𝐼𝐼𝐼𝐼𝐼𝐼𝐼𝐼_𝑃𝑃1はスプリッター
から戻されたポーリングパケットのパワーレベルであり、𝑃𝑃𝐶𝐶𝐶𝐶𝐶𝐶_𝐼𝐼𝐼𝐼𝐼𝐼𝐼𝐼_𝑃𝑃2は DUTの応答パケットのパワー
レベルです。 

2. 𝑃𝑃𝐶𝐶𝐶𝐶𝐶𝐶_𝐼𝐼𝐼𝐼𝐼𝐼𝐼𝐼_𝑃𝑃1と𝑃𝑃𝐶𝐶𝐶𝐶𝐶𝐶_𝐼𝐼𝐼𝐼𝐼𝐼𝐼𝐼_𝑃𝑃2の相対パワーレベル差は 10 dB以下である必要があります。 

この基準が満たされない場合、UWB ToFキット（R&S CM-Z300A）に付属するアッテネータを信号経路に追
加することで、パワーレベルを調整できます。 

 

図 5‑5：ToF校正／検証時のパワーレベルに関する考慮事項 

パワーレベル計算に使用する式を以下に示します。 

式 5‑1 

𝑃𝑃𝐷𝐷𝐷𝐷𝐷𝐷_𝑅𝑅𝑅𝑅＝𝑃𝑃𝐶𝐶𝐶𝐶𝐶𝐶_𝐼𝐼𝐼𝐼𝐼𝐼𝐼𝐼𝐼𝐼－全経路損失 

ここで、信号経路の全経路損失は表 3‑3 に示されています。𝑃𝑃𝐷𝐷𝐷𝐷𝐷𝐷_𝑅𝑅𝑅𝑅は DUTの受信パワーであり、テストプ
ランエディターで ToF校正／検証ルーチンに対して入力する必要があります（"Power RX"、第 3.3.2.3 章、
第 3.4.3 章、付録 B.4 を参照）。𝑃𝑃𝐶𝐶𝐶𝐶𝑃𝑃_𝐼𝐼𝐼𝐼𝐼𝐼𝐼𝐼𝐼𝐼は、CMP200 の IFout ポートでの出力パワーレベルです。 

式 5‑2 

𝑃𝑃𝐷𝐷𝐷𝐷𝐷𝐷_𝑇𝑇𝑇𝑇 < 14 dBm 

𝑃𝑃𝐷𝐷𝐷𝐷𝐷𝐷_𝑇𝑇𝑇𝑇は DUTの送信公称パワーであり、テストプランエディターで ToF校正／検証ルーチンに対して入力
する必要があります（"Power TX"、第 3.3.2.3章、第 3.4.3章、付録 B.4を参照）。これは DUTベンダーによっ
て指定される値です。ここに示す例では、NXP によって [14]で定義されています。式 5‑3 

𝑃𝑃𝐶𝐶𝐶𝐶𝐶𝐶_𝐼𝐼𝐼𝐼𝐼𝐼𝐼𝐼_𝑃𝑃1 = 𝑃𝑃𝐶𝐶𝐶𝐶𝐶𝐶_𝐼𝐼𝐼𝐼𝐼𝐼𝐼𝐼𝐼𝐼 − 𝑃𝑃𝑃𝑃𝑃𝑃ℎ𝑙𝑙𝑙𝑙𝑙𝑙𝑙𝑙1 

ここで、Pathloss1 は、CMP200 とスプリッターの間に接続される 2 本のケーブル（各 2 メートル）の損失
と、スプリッターのポート 1 とポート 2 の間のアイソレーションを示します。ケーブルの代表的な経路損失
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は約 2.2 dBです。スプリッターのアイソレーションの動作周波数における正確な値は、付録 A に示すスプリ
ッターのデータシートに記載されています。 

式 5‑4 

𝑃𝑃𝐶𝐶𝐶𝐶𝐶𝐶_𝐼𝐼𝐼𝐼𝐼𝐼𝐼𝐼_𝑃𝑃2＝𝑃𝑃𝐷𝐷𝐷𝐷𝐷𝐷_𝑇𝑇𝑇𝑇－全経路損失 

DUTの受信パワー𝑃𝑃𝐷𝐷𝐷𝐷𝐷𝐷_𝑅𝑅𝑅𝑅と送信パワー𝑃𝑃𝐷𝐷𝐷𝐷𝐷𝐷_𝑇𝑇𝑇𝑇が ToF校正／検証ルーチンで設定されていれば、CMP200 側
のすべてのパワーレベル𝑃𝑃𝐶𝐶𝐶𝐶𝐶𝐶_𝐼𝐼𝐼𝐼𝐼𝐼𝐼𝐼𝐼𝐼、𝑃𝑃𝐶𝐶𝐶𝐶𝐶𝐶_𝐼𝐼𝐼𝐼𝐼𝐼𝐼𝐼_𝑃𝑃1、𝑃𝑃𝐶𝐶𝐶𝐶𝐶𝐶_𝐼𝐼𝐼𝐼𝐼𝐼𝐼𝐼_𝑃𝑃2は、上記の式を適用することで求められます。
この章の最初に記述されている 2 つの基準が満たされているかどうかを確認し、満たされていない場合は、
基準が満たされるまで𝑃𝑃𝐷𝐷𝐷𝐷𝐷𝐷_𝑅𝑅𝑅𝑅と𝑃𝑃𝐷𝐷𝐷𝐷𝐷𝐷_𝑇𝑇𝑇𝑇を異なる値に調整して試してみます。 

次の例では、DUT が Vivaldi 測定アンテナから 15 cmの距離に配置されています。チャンバーには、RFスイ
ッチが備わっています（システムバリアント 2）。信号経路にアッテネータは接続されていません。テスト
する UWBチャネルは 5（6.5 GHz）です。このセットアップと設定の場合にレベル計算に使用されるパワー
レベルと経路損失を下の表 5‑7 に示します。 

パワーレベル／経路損失 値 注記 

𝑷𝑷𝑫𝑫𝑫𝑫𝑫𝑫_𝑹𝑹𝑹𝑹 －64 dBm WMT で設定された DUTの受信パワーレベル 

𝑷𝑷𝑫𝑫𝑫𝑫𝑫𝑫_𝑻𝑻𝑻𝑻 2 dBm WMT で設定された DUTの送信パワーレベル 

全経路損失 36,3 表 3‑3 を参照（システムバリアント 2、6 dB アッテネー
タ） 

𝑷𝑷𝑪𝑪𝑪𝑪𝑪𝑪_𝑰𝑰𝑰𝑰𝑰𝑰𝑰𝑰𝑰𝑰 －27.7 dBm Apply（Apply（適用）） 式 5‑1 

𝑷𝑷𝑪𝑪𝑪𝑪𝑪𝑪_𝑰𝑰𝑰𝑰𝑰𝑰𝑰𝑰_𝑷𝑷𝑷𝑷 －34.3 dBm 式 5‑4 を適用、＞－50 dBm  

𝑷𝑷𝑷𝑷𝑷𝑷𝑷𝑷𝑷𝑷𝑷𝑷𝑷𝑷𝑷𝑷𝑷𝑷 10.62 dB（2×2.2 dB のケーブル損失＋6.22 dB のア
イソレーション） 

固定値 

𝑷𝑷𝑪𝑪𝑪𝑪𝑪𝑪_𝑰𝑰𝑰𝑰𝑰𝑰𝑰𝑰_𝑷𝑷𝑷𝑷 －38.32 dBm 式 5‑3 を適用、＞－50 dBm 

| 𝑷𝑷𝑪𝑪𝑪𝑪𝑪𝑪_𝑰𝑰𝑰𝑰𝑰𝑰𝑰𝑰_𝑷𝑷𝑷𝑷- 𝑷𝑷𝑪𝑪𝑪𝑪𝑪𝑪_𝑰𝑰𝑰𝑰𝑰𝑰𝑰𝑰_𝑷𝑷𝑷𝑷 | 4.02 dB  ＜10 dB 

表 5‑7：ToF校正／検証のパワーレベル設定の例  

この例の設定では、パワーレベル基準が満たされています。すなわち、𝑃𝑃𝐶𝐶𝐶𝐶𝐶𝐶_𝐼𝐼𝐼𝐼𝐼𝐼𝐼𝐼_𝑃𝑃1と𝑃𝑃𝐶𝐶𝐶𝐶𝐶𝐶_𝐼𝐼𝐼𝐼𝐼𝐼𝐼𝐼_𝑃𝑃2は－50 dBm

を超えています。その差は 4.02 dBで、10 dBを下回っています。校正では、WMTテストプランエディター
で入力された𝑃𝑃𝐷𝐷𝐷𝐷𝐷𝐷_𝑅𝑅𝑅𝑅と𝑃𝑃𝐷𝐷𝐷𝐷𝐷𝐷_𝑇𝑇𝑇𝑇の値が正しいことが確認されました。 

UWBパワーレベル計算のための "UWB Power Level Calculation" というツールが、Gloris（https://gloris.rohde-

schwarz.com/）からダウンロードできます。このツールを使えば、𝑃𝑃𝐷𝐷𝐷𝐷𝐷𝐷_𝑅𝑅𝑅𝑅と𝑃𝑃𝐷𝐷𝐷𝐷𝐷𝐷_𝑇𝑇𝑇𝑇を簡単に求めることがで
きます。 

https://gloris.rohde-schwarz.com/
https://gloris.rohde-schwarz.com/
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E 波形ファイルの取り扱い 

レシーバーテストや ToFテストには、波形ファイル（任意波形ファイル）が必要です。テストルーチンを開
始する前に、必要な波形ファイルが CMP200 で使用可能であることを確認してください。使用可能でない場
合は、あらかじめ CMsquaresで波形ファイル（.wv）を CMP200 にアップロードしておく必要があります。 

CMsquaresでのアップロード操作を図 5‑6 に示します。 

 

 

図 5‑6：CMsquaresから CMP200への波形ファイルのアップロード 

1. CMP200 の IPアドレスを制御 PCのウェブブラウザーに入力して、CMsquaresにアクセスします。
CMsquares（CMP200 のウェブインタフェース）がロードされたら、ハンバーガーメニューをクリック
します。 

2. ドロップダウンメニューで "File Explorer" を選択します。 

3. CMsquaresでファイルエクスプローラーが開いたら、"waveform" フォルダーに移動します。 

4. アップロードする波形ファイルを選択し、"Upload" ボタンを押します。 

レシーバーテストの場合、波形ファイルの別の取り扱い方法があります。テストルーチンのテストプランエ
ディターで任意波形ファイルが明示的に指定されていない場合（"Waveform" パラメータ設定フィールドに 

"None" が設定されている場合）、テストプランエディターでのレシーバーテストのパラメータ設定に基づ
いて、ローカル制御 PC上に任意波形ファイルが WinIQSIM2 によってオンザフライで作成されます。作成さ
れた任意波形ファイルは、後でテスト実行中に CMP200 に転送されます。そのためには、ルーチンの実行前
に WinIQSIM2 を起動し、バックグラウンドで実行しておく必要があります。 

1 

2 

3 

4 
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F レシーバー感度探索 

図 5-7 に、レシーバー感度探索のフローチャートを示します。初期最大レシーバーパワーレベル𝑃𝑃_𝑀𝑀𝑀𝑀𝑀𝑀、最
小レシーバーパワーレベル𝑃𝑃_𝑀𝑀𝑀𝑀𝑀𝑀、𝐷𝐷𝐷𝐷𝐷𝐷𝐷𝐷𝐷𝐷値はパラメータであり、3.4.2 と付録 B.3 の記述に従って、レシーバ
ー感度ルーチンで設定しておく必要があります。 

感度探索は、（𝑃𝑃_𝑀𝑀𝑀𝑀𝑀𝑀＋𝑃𝑃_𝑀𝑀𝑀𝑀𝑀𝑀）/2のパワーレベルから始まります。探索中に、𝑃𝑃_𝑀𝑀𝑀𝑀𝑀𝑀と𝑃𝑃_𝑀𝑀𝑀𝑀𝑀𝑀は、PER の
測定結果と、ターゲット感度リミットとの比較に基づいて、動的に変更されます。𝑃𝑃_𝑀𝑀𝑀𝑀𝑀𝑀と𝑃𝑃_𝑀𝑀𝑀𝑀𝑀𝑀の 2 つの
値が𝐷𝐷𝐷𝐷𝐷𝐷𝐷𝐷𝐷𝐷 dB以内のパワー差に集束するまで、反復処理が続けられます。  

𝑃𝑃_𝑀𝑀𝑀𝑀𝑀𝑀、 𝑃𝑃_𝑀𝑀𝑀𝑀𝑀𝑀、𝐷𝐷𝐷𝐷𝐷𝐷𝐷𝐷𝐷𝐷のパラメータ設定は、レシーバー感度探索の速度と確度に影響する場合がありま
す。 

 

図 5-7：レシーバー感度探索のフローチャート 
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